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PREFACE 

Although teak plantations have expanded rapidly over the past decades in Lao 
PDR, a number of smallholders who has formally registered their plantation is 
small. Development of a legal registration system for teak plantations in Luang 
Prabang is facing difficulties due to a lack of financial support and human resource, 
including capacity to carry out a regular teak inventory, inconsistent teak plantation 
registration database and GIS skills at provincial and district level. 

With financial support of the Australian Government through the Responsible Asia 
Forestry and Trade (RAFT-3) partnership for a project in Lao PDR, Institute for 
Global Environmental Strategies (IGES) in cooperation with Faculty of Forest 
Science, National University of Laos (NUOL) develops the training programme on 
“Mapping and Creating GIS Database of Teak Plantations” for provincial forestry 
officers in Luang Prabang Province. The 5 days training runs from 6-10 February 
2017.  

This “Manual for GIS Training Workshop on Mapping and Creating GIS Database 
of Teak Plantations” is designed to support provincial forestry officials during the 
workshop which aims to improve their learning on how to use the GIS and Remote 
Sensing for mapping and monitoring teak plantations at the provincial level. The 
manual has been developed by NUOL and IGES. Thus, authors wish the manual 
will provides useful and clear guidance for trainees. Finally, any comment and 
suggestions for improving this manual are kindly welcome. 

 

Jintana Kawasaki, IGES  
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ບົດທີ  1 ຄວາມຮູ້ພ້ືນຖານກ່ຽວກັບລະບົບຂໍ ້ ມູນຂ່າວສານທາງພູມີ ສາດ 

1.1 GIS ແມ່ນຫຍັງ (What is a GIS?) 

GIS ຫຍໍ ້ ມາຈາກຄໍ າເຕັມວ່າ Geographic Information Systems ຊຶ່ ງແປເປັນພາສາລາວວ່າ 
“ລະບົບຂໍ ້ ມູນຂ່າວສານທາງພູມີ ສາດ” ນ້ັນກໍຄື ລະບົບເຄື່ ອງມື ທີ່ ມີ ປະສິ ດທິພາບໃນການເກັບ
ຮວບຮວມຂໍ ້ ມູນພ້ືນທີ່  ແລະ ເຊື່ ອມໂຍງປະສົມປະສານຂໍ ້ ມູນທັງຂໍ ້ ມູນທາງພ້ືນທີ່  ແລະ ຂໍ ້ ມູນທາງ
ບັນຍາຍທີ່ ເກັບໄວ້ໃນຖານຂໍ ້ ມູນສາມາດດັດແປງ ແກ້ໄຂ ວິ ເຄາະ ສະແດງຜົນການວິ ເຄາະ ແລະ 
ການນໍ າສະເໜີຂໍ ້ ມູນ ເພ່ືອໃຫ້ເຫັນມິຕິ ແລະ ຄວາມສໍ າພັນດ້ານພ້ືນທີ່ ຂອງຂໍ ້ ມູນ ຊຶ່ ງມີ ສ່ວນຊ່ວຍ
ໃຫ້ເກີ ດຄວາມເຂົ ້ າໃຈດ້ານບັນຫາຕ່າງໆ ແລະ ປະກອບການຕັດສິ ນໃຈໃນການແກ້ບັນຫາກ່ຽວກັບ
ການວາງແຜນການໃຊ້ຊັບພະຍາກອນທາງພ້ືນທີ່ . 

ລະບົບຂໍ ້ ມູນຂ່າວສານທາງພູມີ ສາດຫືຼ GIS ຖື ກນໍ າມາໃຊ້ໃນຫຼາຍສາຂາເຊັ່ ນ ທາງທຸລະກິດ, ການ 
ຂົນສ່ົງ, ສາທາລະນະສຸກ, ການກະເສດ, ການຈັດການຊັບພະຍາກອນທໍາມະຊາດ, ການວາງແຜນ 
ການໃຊ້ປະໂຫຍດທີ່ ດິ ນ, ການປະເມີ ນສິ່ ງແວດລອ້ມ, ການວາງແຜນຜັງເມື ອງ ແລະ ອື່ ນໆ GIS ຖື ກ 
ນໍ າມາໃຊ້ໃນລະບົບອິ ນເຕິເນັດຢ່າງຫຼວງຫຼາຍ ຊຶ່ ງເປັນເທັກໂນໂລຢີ ທີ່ ກໍາລັງນິ ຍົມກັນໃຊ້ຢ່າງແຜ່
ຫຼາຍ ໃນປັດຈຸບັນ ພ້ືນຖານຂອງ GIS ເປັນພຽງເຄື່ ອງມື ທາງຄອມພິວເຕີ  ສໍ າຫັຼບແກ້ໄຂບັນຫາ
ຕ່າງໆ ສາ ມາດປະມວນຂໍ ້ ມູນໄດ້ຈາກຫຼາຍແຫ່ຼງ ແລະ ນໍ າມາສະເໜີໃຫ້ເຮົ າໄດ້ເຂົ ້ າໃຈ ແລະ ຄ້ົນຫາ
ບັນຫາຈາກຂໍ ້ ມູນພ້ືນໂລກຈິ ງ ກໍຈະໄດ້ຈັດເກັບລົງໄວ້ເປັນຖານຂໍ ້ ມູນແລ້ວນໍ າມາສະເໜີຜ່ານໜ້າຈໍ
ຄອມພິວເຕີ  ຊຶ່ ງສາມາດເຊື່ ອມໂຍງກັບຂໍ ້ ມູນທີ່ ປ່ຽນແປງເຄື່ ອນໄຫວຢູ່ຕະລອດເວລາ (Dynamic) 
ເມື່ ອມີການປ່ຽນ ແປງຂໍ ້ ມູນ ການສະແດງຜົນທາງ GIS ກໍຈະສະແດງອອກມາເປັນຜົນທີ່ ປ່ຽນແປງ
ໄດ້ທັນທີ  ໂດຍທ່ົວໄປເຮົ າຈະໃຊ້ GIS ເພ່ືອຈຸດປະສົງຫັຼກ 4 ຂໍ ້  ຄື   

1. ຮວບຮວມຂໍ ້ ມູນ  

2. ສະແດງຜົນຂໍ ້ ມູນ 

3. ວິ ເຄາະຂໍ ້ ມູນ ແລະ  

4. ຈັດທໍາຜົນງານ   
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1.2 ອົງປະກອບຂອງ GIS (Components of a GIS)  

ເນື່ ອງຈາກລັກສະນະຂໍ ້ ມູນຂອງລະບົບຂໍ ້ ມູນຂ່າວສານທາງພູມີ ສາດມີ ຄວາມສັບຊອ້ນໂດຍຕົວຂອງ
ຕົວເອງການປະມວນຜົນຂໍ ້ ມູນຂອງລະບົບຂໍ ້ ມູນຂ່າວສານທາງພູມີ ສາດຈຶ່ ງມັກນິ ຍົມນໍ າໃຊ້ເຄື່ ອງ
ສະໝອງກົນ ທີ່ ມີ ຄວາມສາມາດສູງ (High Speed Computer) ມາໃຊ້ເປັນຫັຼກ ເພາະສະນ້ັນຈຶ່ ງ
ເຮັດໃຫ້ສາມາດຈໍ າແນກອົງປະກອບຂອງ GIS ອອກເປັນ 5 ລະບົບໃຫຍ່ ຄື   

1. ຄົນ  

2. ຂໍ ້ ມູນ  

3. ຮາດແວ  

4. ຊອຟແວ  

5. ຂ້ັນຕອນຕ່າງໆ ດ່ັງຮູບ 

 

 

 

 

 

 

 

 

 

ຮູບ1.1 ອົງປະກອບທັງ 5 ປະການຂອງGIS 

 ຄົນເປັນອົງປະກອບທີ່ ຖື ວ່າສໍ າຄັນທີ່ ສຸດເຖິງແມ່ນວ່າຈະມີຄອມພິວເຕີທີ່ ດີ  ແລະ ມີ
ຊອຟແວທີ່ ທັນສະໄໝກໍບໍ່ ສາມາດປຽບທຽບກັບຄົນໄດ້  

 ຂໍ ້ ມູນຄວນມີຄວາມຖືກຕອ້ງ ເພາະຄວາມຖືກຕອ້ງຂອງຂໍ ້ ມູນຈະມີຜົນຕ່ໍການສື ບ
ຄ້ົນ ຫຼື  ການວິ ເຄາະຂໍ ້ ມູນ 

 ປະສິ ດທິພາບຂອງຮາດແວຈະຂຶ ້ ນຢູກັບຄວາມໄວໃນການປະມວນຜົນຂໍ ້ ມູນ  

 ຊອບແວບໍ່ ໄດ້ປະກອບດ້ວຍຊອຟແວທາງ GIS ເທົ່ ານ້ັນແຕ່ລວມເຖິງຊອຟແວທາງ
ດ້ານຖານຂໍ ້ ມູນສະຖິຕິຈັດການພາບ ແລະ ອື່ ນໆ  

 ຂ້ັນຕອນການຈັດການໃນຂະບວນການວິ ເຄາະທາງ GIS ຕອ້ງການການວາງແຜນທີ່
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ດີ  ຊຶ່ ງປະ ກອບດວ້ຍວິ ທີ ການ ແລະ ຂ້ັນຕອນທີ່ ຖື ກຕອ້ງ ຊຶ່ ງສາມາດນໍ າກັບມາໃຊ້ໃໝ່
ໄດ້ອີ ກ  

1.3 ສ່ວນປະກອບຂອງຂໍ ້ ມູນທາງພູມີ ສາດ (Components of geographic data) 

 ຂໍ ້ ມູນທາງພູມີ ສາດມີ ສ່ວນປະກອບຫັຼກ 3 ຢ່າງຄື   
 ຂໍ ້ ມູນທາງພ້ືນທີ່  (Spatial Data) ເປັນຂໍ ້ ມູນທີ່ ນໍ າສະເໜີກ່ຽວກັບຮູບຊົງ ແລະ ຕໍາແໜ່ງ

ຈາກພ້ືນໂລກຈິ ງຈະຖື ກນໍ າສະເໜີໃນຮູບແບບຈຸດ (Point) ເສ້ັນ (Line) ແລະຮູບປິ ດຫຼາຍ
ຫ່ຼຽມ (Polygon)  

 ຂໍ ້ ມູນທາງບັນຍາຍ (Attributes Data) ເປັນຂໍ ້ ມູນທີ່ ຈະອະທິບາຍເຖິງຄຸນລັກສະນະຂອງຂໍ ້
ມູນທາງພູມີ ສາດ  

 ຂໍ ້ ມູນທາງພຶດຕິກໍາ (Behavior Data) ໝາຍເຖິງການກໍາໜົດເງື່ ອນໄຂ ຫຼື  ລັກສະນະຂອງຂໍ ້
ມູນທີ່ ຜູ້ໃຊ້ກໍານົດຕາມສະພາບແວດລອ້ມຈິ ງຂອງຂໍ ້ ມູນນ້ັນໆ 
 

 
ຮູບ1.2 ຮູບເທິງນີ ້ ເປັນຮູບຂອງເມືອງໜ່ຶງທີ່ ຖື ກນໍ າສະເໜີອອກໃນຮູບແບບ GIS ຮູບຊົງທີ່ ນໍ າສະເ
ໜີແທນຖະນົນເປັນຮູບເສ້ັນໃນແຕ່ລະເສ້ັນທາງມີ ຂໍ ້ ມູນທາງບັນຍາຍເປັນຊື່ ຂອງຖະນົນຢູ່ຜູ້ໃຊ້
ສາມາດກໍາໜົດເງື່ ອນໄຂງ່າຍທີ່ ເປັນພຶດຕິກໍາຂອງຂໍ ້ ມູນເຊັ່ ນ ຖະນົນຕ້ອງບໍ່ ສາມາດມີ ເກີນກວ່າ 4 

ຊອ່ງທາງ 

1.4 ຂໍ ້ ມູນທາງພ້ືນທີ່ ສໍ າພັນກັນແນວໃດ (How a GIS organizes geographic 
data)  

ໂຄງສ້າງການຈັດເກັບຂໍ ້ ມູນຂອງ GIS ຈະຈັດເກັບຂໍ ້ ມູນເປັນກຸ່ມຂອງຊ້ັນຂໍ ້ ມູນໂດຍທຸກໆ ຊ້ັນຂໍ ້ ມູນ
ຈະເຊື່ ອມໂຍງກັນໂດຍຄ່າພິກັດທາງພູມີ ສາດໃນແຕ່ລະຊ້ັນຂໍ ້ ມູນຈະປະກອບດວ້ຍຂໍ ້ ມູນທີ່ ມີ
ລັກສະນະຄ້າຍຄື ກັນເຊັ່ ນ  ຊ້ັນຂໍ ້ ມູນຖະນົນ ຊ້ັນຂໍ ້ ມູນຂອບເຂດແຂວງ ດວ້ຍຮູບແບບການຈັດເກັບ
ແບບງ່າຍໆນີ ້ ແຕ່ເປັນແນວທາງທີ່ ມີ ປະໂຫຍດຫຼາຍໃນການແກ້ໄຂບັນຫາຂອງພ້ືນໂລກຕົວຈິ ງ 
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ຮູບ1.3 ຈາກຮູບມີ  4 ຊ້ັນຂໍ ້ ມູນລວມກັນຢູ່ໃນຖານຂໍ ້ ມູນຂອງເມືອງໜ່ຶງທຸກໆ ຊ້ັນຂໍ ້ ມູນຈະມີ ຂໍ ້ ມູນ
ຕາມຂອບເຂດຂອງເມື ອງເທ່ົານ້ັນແຕ່ໃນແຕ່ລະ ຊ້ັນຂໍ ້ ມູນຈະນໍ າສະເໜີຂໍ ້ ມູນທີ່ ແຕກຕ່າງກັນ

ອອກໄປ 

1.5 ການລວບລວມຂໍ ້ ມູນ (Capturing data)  

GIS ຕອ້ງສາມາດລວບລວມຂໍ ້ ມູນທາງພູມີ ສາດໃຫ້ຢູ່ໃນຮູບຂອງຖານຂໍ ້ ມູນທາງພູມີ ສາດໄດ້ຊຶ່ ງ
ຖານຂໍ ້ ມູນທາງພູມີ ສາດເປັນອົງປະກອບທີ່ ມີ ລາຄາແພງ ແລະ ມີ ອາຍຸການໃຊ້ງານທີ່ ຍາວນານ ດ່ັງ
ນ້ັນ, ການນໍ າເຂົ ້ າຂໍ ້ ມູນຂອງ GIS ຈະຕອ້ງໄດ້ຄໍ ານຶ ງເຖິງຄວາມຖື ກຕອ້ງເປັນສໍ າຄັນສ່ວນວິ ທີ ການ
ນໍ າແຜນທີ່ ທີ່ ມີ ຢູ່ເກັບເຂົ ້ າເປັນຖານຂໍ ້ ມູນ ຫຼື  ຈະນໍ າໃຊ້ຮູບແບບໃດທີ່ ຈະຈັດເກັບນ້ັນໂປຣແກຣມ
ທາງ GIS ຈະຕອ້ງມີ ລໍ າດັບຂ້ັນຕອນສໍ າຫັຼບການນໍ າເຂົ ້ າຂໍ ້ ມູນທາງພູມີ ສາດໃຫ້ມີ ທັງຄ່າພິກັດ ແລະ 
ຂໍ ້ ມູນທາງຕາລາງ ສํາຫັຼບການນໍ າເຂົ ້ າສາມາດເຮັດໄດ້ຫຼາຍທາງຕາມແຕ່ຄວາມສະດວກ ແລະ ກົນ
ໄກທາງເທັກ ນິ ກ  

 
 ຮູບ1.4 ເຮົ າສາມາດນໍ າເຂົ ້ າຂໍ ້ ມູນຈາກຫຼາຍແຫ່ຼງຂໍ ້ ມູນເຂົ ້ າສູ່ລະບົບ GIS 
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1.6 ການຈັດເກັບຂໍ ້ ມູນ (Storing data)  

ການຈັດເກັບຂໍ ້ ມູນທາງ GIS ມີ   2 ປະເພດຫັຼກ ຄື  1. ເວກເຕີ  (Vecter) ແລະ 2. ຣາສເຕີ  (Raster) 
ໂດຍທ່ົວໄປໂປຣແກຣມທາງ GIS ຄວນມີ ຄວາມສາມາດໃນການຈັດເກັບຂໍ ້ ມູນທັງ 2 ແບບ  

 
ຮູບ 1.5 ຜົນການສະແດງພາບອອກມາທາງລະບົບ GIS ຈະສະແດງອອກມາຕາມຮູບແບບການ

ຈັດເກັບຂອງຂໍ ້ ມູນນ້ັນໆ 

ຮູບແບບເວກເຕີ (Vecter) ຈະສະແດງລັກສະນະທາງພູມີ ສາດດວ້ຍການນໍ າສະເໜີຄ້າຍຄື ກັບຮູບ
ແບບແຜນທີ່ ຄື ສະແດງອອກມາເປັນຈຸດ (Point) ເສ້ັນ (Line) ແລະ ຮູບປິ ດຫຼາຍຫ່ຼຽມ (Polygon) 
ໂດຍທຸກໆຈຸດຂອງຂໍ ້ ມູນຈະມີ ຄ່າພິກັດ X, Y ເປັນຕົວອ້າງອີ ງທຽບກັບຕໍາແໜ່ງເທິງໜ້າໂລກຈິ ງ  

ຮູບແບບຣາສເຕີ (Raster) ຈະສະແດງລັກສະນະທາງພູມີ ສາດດວ້ຍການນໍ າສະເໜີແບບຕາ 
ລາງກຣີ ດໂດຍການກໍານົດຄ່າທີ່ ຕອ້ງການໃຫ້ໄວ້ໃນຕາລາງກຣີ ດນ້ັນໆ ລວມທັງຄ່າພິກັດໃນບໍ ລິ ເວນ
ລັກສະນະທາງພູມີ ສາດທີ່ ຄວບຄຸມຢູ່ ສໍ າຫັຼບຄວາມລະອຽດຂອງຂໍ ້ ມູນຂຶ ້ ນຢູ່ກັບຂະໜາດຂອງ
ຕາລາງກຣີ ດຮູບແບບຣາສເຕີນີ ້ ເໝາະສົມ ສາํຫັຼບການນໍ າມາວິ ເຄາະຂໍ ້ ມູນທາງພ້ືນທີ່  ແຕ່ຈະບໍ່ ເໝ
າະສົມກັບການນໍ າໃຊ້ລັກສະນະການຈັດການທີ່ ດິ ນ ແລະ ຂອບເຂດຕ່າງໆ  

1.7 ການສື ບຄ້ົນຂໍ ້ ມູນ (Querying data)  

GIS ຈະມີ ເຄື່ ອງມື ເພ່ືອຄ້ົນຫາບໍ ລິ ເວນທີ່ ສົນໃຈຕາມຕໍາແໜ່ງ ແລະ ຕາມຂໍ ້ ມູນທາງບັນຍາຍການ
ສື ບຄ້ົນຂໍ ້ ມູນສາມາດສ້າງເງື່ ອນໄຂສໍ າຫັຼບການສື ບຄ້ົນ ຫຼື  ແບບເລື ອກໂດຍກົງທັງເລື ອກຈາກແຜນ
ທີ່  ແລະ ເລື ອກຈາກແຖວ (record) ໃນຖານຂໍ ້ ມູນ ໂດຍທ່ົວໄປຈະສື ບຄ້ົນຂໍ ້ ມູນ GIS ຈະສື ບຄ້ົນວ່າ ບໍ
ລິ ເວນທີ່ ຜູ້ໃຊ້ຕອ້ງການຢູ່ບໍ ລິ ເວນໃດ ບາງເທື່ ອຜູ້ໃຊ້ຮູ້ພ້ືນທີ່ ວ່າຢູ່ບໍ ລິ ເວນໃດ ແລະ ຕອ້ງການຮູ້ວ່າມີ
ຄຸນລັກສະນະແນວໃດ ຊຶ່ ງລະບົບ GIS ສາມາດໃຫ້ຜູ້ໃຊ້ເລື ອກບໍ ລິ ເວນທີ່ ສົນໃຈຈາກແຜນທີ່  ທີ່ ສະ
ແດງຢູ່ ແລະ ຈາກພ້ືນທີ່ ທີ່ ຖື ກເລື ອກ ກໍຈະເຊື່ ອມໂຍງໄປຫາຂໍ ້ ມູນທາງບັນຍາຍທີ່ ເກັບຢູ່ໃນຖານຂໍ ້

ມູນ  
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ຮູບ1.6 ໃນລະບົບ GIS ຜູ້ໃຊ້ສາມາດເລື ອກບໍ ລິ ເວນທີ່ ສົນໃຈເພື່ ອເບິ່ ງຂໍ ້ ມູນທາງບັນຍາຍທີ່ ໄດ້ຈັດ
ເກັບຢູ່ໃນຖານຂໍ ້ ມູນ 

 ໃນບາງກໍລະນີ ຜູ້ໃຊ້ຕອ້ງການສື ບຄ້ົນຕາມເງື່ ອນໄຂທີ່ ຕອ້ງການໃນກໍລະນີ ທີ່ ຜູ້ໃຊ້ຮູ້ວ່າຄຸນ
ລັກສະນະເດັ່ ນທີ່ ຕອ້ງການຄ້ົນຫາວ່າມີ ລັກສະນະແນວໃດ  

 

 

 
ຮູບ1.7 ສົມມຸດວ່າຕອ້ງການຄ້ົນຫາປະເທດທີ່ ມີ ປະຊາກອນຫຼາຍກວ່າ20ລ້ານຄົນຜູ້ໃຊ້ສາມາດສ້າງ
ເງື່ ອນໄຂສໍ າຫັຼບສື ບຄ້ົນແລ້ວເມ່ືອລະບົບ GIS ຄ້ົນຫາບໍ ລິ ເວນທີ່ ກົງກັບເງື່ ອນໄຂແລ້ວກໍຈະສະແດງ

ໃຫ້ເດັ່ ນຊັດດ່ັງຮູບຂ້າງເທິງ 

1.8 ການວິ ເຄາະຂໍ ້ ມູນ (Analyzing data)  

 ການວິ ເຄາະຂໍ ້ ມູນທາງພູມີ ສາດສ່ວນໃຫຍ່ຈະໃຊ້ຫຼາຍກວ່າໜ່ຶງຊຸດຂໍ ້ ມູນ ແລະ ເຮັດການວິ
ເຄາະຕາມຂ້ັນຕອນໄປຈົນເຖິງຜົນສຸດທ້າຍທີ່ ຕອ້ງການ ໃນລະບົບ GIS ຈະຕອ້ງສາມາດວິ
ເຄາະຂໍ ້ ມູນເພ່ືອຕອບຄໍ າຖາມ ແລະ ແກ້ໄຂບັນຫາທີ່ ໄດ້ກໍານົດຂຶ ້ ນໄວ້ ການວິ ເຄາະຂໍ ້ ມູນທາງ
ພູມີ ສາດມີ ຫຼາຍປະເພດໃນບົດຮຽນຊຸດນີ ້ ບໍ່ ສາມາດຄວບຄຸມທັງໝົດໄດ້ການວິ ເຄາະຂໍ ້ ມູນ
ທາງພູມີ ສາດໂດຍທ່ົວໄປມີ  2 ປະເພດຫັຼກດ່ັງນີ ້   
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 ການວິ ເຄາະສິ່ ງທີ່ ໃກ້ຄຽງ (Proximity analysis)  
 ການວິ ເຄາະສິ່ ງໃກ້ຄຽງແມ່ນໃຊ້ສໍ າຫັຼບຫາສິ່ ງທີ່ ຕອ້ງການພາຍໃນລະຍະທາງຂອງບໍ ລິ ເວນທີ່

ຕ້ັງຄໍ າຖາມເຊັ່ ນ  
 ມີ ເຮື ອນຢູ່ເທ່ົາໃດພາຍໃນບໍ ລິ ເວນ 100 ແມັດ ຈາກແມ່ນໍ ້ າຫັຼກ  
 ມີ ລູກຄ້າຢູ່ເທ່ົາໃດທີ່ ຢູ່ພາຍໃນລະຍະທາງ 10 ກິໂລແມັດ ຈາກຮ້ານຄ້າ  
 ພ້ືນທີ່ ທີ່ ເໝາະສົມສໍ າຫັຼບປູກຖ່ົວພາຍໃນ 500 ແມັດ  
  ໃນການວິ ເຄາະສິ່ ງທີ່ ໃກ້ຄຽງສ່ວນໃຫຍ່ມັກໃຊ້ເທັກນິ ກທາງ GIS ທີ່ ເອີ ້ ນວ່າ ເຂດ

ແນວລະຍະຫ່າງ (Buffering) ເພ່ືອກວດສອບຫາຄວາມສໍ າພັນລະຫວ່າງຂໍ ້ ມູນດວ້ຍກັນ  
 

 

 

 

 

 

ຮູບ1.8 ຕົວຢ່າງນີ ້ ເປັນການສ້າງບັຟເຟີ ລະຍະທາງ 50 ຟຸດຈາກຖະນົນ      ທັງສອງດ້ານທີ່ ນໍ າມາ
ຄ້ົນຫາຕອນທີ່ ດິ ນທີ່ ຢູ່ໃນລະຍະບັຟເຟີ ນີ ້  

 ການວິ ເຄາະການຊອ້ນທັບ (Overlay analysis)  

ການວິ ເຄາະການຊອ້ນທັບເປັນການວິ ເຄາະຂໍ ້ ມູນຫຼາຍຊ້ັນຂໍ ້ ມູນຮ່ວມກັນໂດຍຂໍ ້ ມູນເຫ່ົຼານ້ັນ ຕອ້ງຢູ່
ໃນບໍ ລິ ເວນດຽວກັນ ແລະ ມີ ຄຸນລັກສະນະຕ່າງກັນນໍ າເອົ າຂໍ ້ ມູນເຫ່ົຼານ້ັນມາປະມວນຜົນໂດຍການ
ຊອ້ນທັບກັນ ຊຶ່ ງສາມາດເຮັດໄດ້ດວ້ຍວິ ທີ ການງ່ າຍໆເຊັ່ ນ ດວ້ຍການຊອ້ນທັບເທິງແຜ່ນໄສ ການ
ຊອ້ນທັບລະຫວ່າງຂໍ ້ ມູນດິ ນ ຄວາມລາດຊັນ ແລະ ພື ດພັນ, ຂໍ ້ ມູນເຈົ ້ າຂອງທີ່ ດິ ນກັບຂໍ ້ ມູນການປະ
ເມີ ນພາສີ ທີ່ ດິ ນ ຜົນຈາກການວິ ເຄາະຈະເຮັດໃຫ້ໄດ້ຊ້ັນຂໍ ້ ມູນໃໝ່ 

 

 
ຮູບ1.9 ຕົວຢ່າງເທິງນີ ້ ເປັນການວິ ເຄາະການຊອ້ນທັບຂໍ ້ ມູນເພ່ືອໃຫ້ໄດ້ຜົນເປັນຄວາມເໝາະສົມ

ຂອງການໃຊ້ປະໂຫຍດທີ່ ດິ ນ 
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1.9 ການສະແດງຜົນ (Displaying data)  

GIS ມີ ເຄື່ ອງມື ໃນການສະແດງຂໍ ້ ມູນດ້ານພູມີ ສາດ ໂດຍການໃຫ້ສັນຍະລັກທີ່ ແຕກຕ່າງກັນສໍ າຫັຼບ
ຂະບວນການວິ ເຄາະຂໍ ້ ມູນຜົນທີ່ ໄດ້ຈາກການວິ ເຄາະຂໍ ້ ມູນສາມາດນໍ າສະເໜີ ຫຼື  ສະແດງຜົນໄດ້ທາງ 
ຈໍ ຄອມພິວເຕີ  (Monitor) ຊຶ່ ງສາມາດຜະລິ ດອອກເປັນເອກະສານ (ແຜນທີ່  ແລະ ຕາລາງ) ໂດຍໃຊ້ 
ເຄື່ ອງພິມ ຫຼື  Plotter  ຫຼື  ສາມາດແປງຂໍ ້ ມູນເຫ່ົຼານ້ັນໄປສູ່ລະບົບການເຮັດວຽກໃນໂປຣແກຣມອື່ ນໆ 
ໃນຮູບຂອງແຜນທີ່  (Map)  ກຣາຟ (Chart)  ຫຼື  ຕາລາງ (Table) ເພ່ືອໃຫ້ເບິ່ ງໄດ້ເຂົ ້ າໃຈງ່ າຍຂຶ ້ ນ. 

ໃນອະດີ ດນັກແຜນທີ່ ໄດ້ສ້າງແຜນທີ່ ທີ່ ມີ ປະສິ ດທິພາບສູງ ໃນການນໍ າສະເໜີຂໍ ້ ມູນດ້ານພູມີ ສາດສໍ າ
ຫັຼບຄົນທ່ົວໄປແຕ່ດວ້ຍເທັກນິ ກທາງດ້ານ GIS ເຄື່ ອງມື ໃໝ່ໆສໍ າຫັຼບສ້າງງານ ຊຶ່ ງເປັນວິ ທະຍາ ສາດ 
ແລະ ສິ ນລະປະສາດ ສໍ າຫັຼບສ້າງແຜນທີ່  ຊຶ່ ງສາມາດເພ່ີມອົງປະກອບຂອງລາຍງານ, ກຣາຟ, ຮູບ
ພາບ ແລະ ຜົນງານອື່ ນໆ ລວມທັງລະບົບສື່ ປະສົມດວ້ຍ 

 

 
ຮູບ1.10 ດວ້ຍລະບົບ GIS ຜູ້ໃຊ້ສາມາດສະແດງຂໍ ້ ມູນໄດ້ຫຼາຍຮູບແບບຕາມຄວາມເໝາະສົມ 

ແລະຈຸດປະສົງທີ່ ຕອ້ງການລວມທັງເຮັດໃຫ້ຜູ້ອື່ ນເຂົ ້ າໃຈງ່ າຍດວ້ຍ 
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ບົດທີ  2: ການນໍ າໃຊ້ໂປຼແກມ ArcMap 

2.1. ພາກສະເໜີກ່ຽວກັບໂປຼແກຼມ ArcMap 

GIS ສາມາດນໍ າໄປປະຍຸກໃຊ້ງານໄດ້ຫຼາກຫຼາຍລະດັບໂຄງງານ ເຊິ່ ງອາດສາມາດເລື ອກຈັດການໃນ
ລະດັບ Desktop GIS database ສໍ າຫັຼບໂຄງງານຂະໜາດນອ້ຍ ສາํຫັຼບໂຄງງານທີ່ ຕອ້ງການ
ພັດທະນາຂໍ ້ ມູນເຊີ ງພ້ືນທີ່ ແລະແບ່ງປັນຊັບພະຍາກອນຂໍ ້ ມູນໃຫ້ກັບທິມງານພາຍໃຕ້ລະບົບ LAN 
(Local Area Network) ກໍອາດຈໍ າເປັນຕອ້ງເລື ອກຈັດການໃນລະດັບ GIS Enterprise ເພາະຜູ້ໃຊ້
ບາງຄົນຕອ້ງການຮຽກເບິ່ ງຂໍ ້ ມູນ ສື ບຄ້ົນຂໍ ້ ມູນຈາກຖານຂໍ ້ ມູນ ໃນຂະນະທີ່ ຜູ້ໃຊ້ຄົນອື່ ນກํາລັງປັບ
ແກ້ຂໍ ້ ມູນ ແລະຂໍ ້ ມູນນີ ້ ກໍຍັງຄົງທໍາການວິ ເຄາະທີ່ ຊັບຊອ້ນຢູ່ຫຼື ບາງຄົນກໍກໍາລັງເຮັດແຜນທີ່ ແລະ
ອາດເຮັດລາຍງານຢູ່ 

 

2.2. ເມນູຄໍ າສ່ັງຫັຼກ (Main Menu) 

ເມນູຄໍ າສ່ັງຫັຼກ (Main Menu) ປະກອບມີ ທັງໝົດ 10 ລາຍການ ຊຶ່ ງປະກອບມີ ຟ່ັງຊັນຕ່າງໆດ່ັງນີ ້ : 
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 ແຖບເມນູຄໍ າສ່ັງຫັຼກ (Main Menu)  

 

 ເມນູ File  

  
 
 
ເມນູ Edit ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ ການສໍ າເນົ າຊ້ັນຂໍ ້ ມູນ ການວາງ ການ
ຍົກເລີ ກ ແລະການຍ້ອນກັບດ່ັງນີ ້ ເປັນຕ້ົນ  

 
 
 

New ສ້າງໂຄງງານໃໝ່ທີ່ ມີ ນາມສະກຸນເປັນ .mxd  
Open ໂຄງງານທີ່ ມີ ນາມສະກຸນເປັນ .mxd  
Save ບັນທຶກໂຄງງານທີ່ ມີ ນາມສະກຸນເປັນ .mxd   
Save As… ບັນທຶກໂຄງງານທີ່ ມີ ນາມສະກຸນ
ເປັນ .mxd  ແລະກໍານົດຊື່ ໂຄງງານໃໝ່ 
 

Undo Add Layer ຍົກເລີ ກຄໍ າສ່ັງເທື່ ອລະໜ່ຶງຄໍ າສ່ັງ  
Redo ຢ້ອນກັບຄໍ າສ່ັງຍົກເລີ ກ Undo  
Copy ຄັດລອກຊ້ັນຂໍ ້ ມູນທີ່ ສົນໃຈ  
Paste ວາງຊ້ັນຂໍ ້ ມູນທີ່ ໄດ້ຄັດລອກ 
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ເມນູ View ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ   

 
 
 
ເມນູ Bookmarks ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ 

 
Create Bookmark ສ້າງບຸກມາກ ຫຼື  ສ້າງບ່ອນຂ້ັນແຜນທີ່  
Manage Bookmarks ການເຮັດວຽກກັບບຸກມາກ 
 
ເມນູ Insert ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ ການສ້າງກອບຂໍ ້ ມູນໃໝ່ ການໃສ່ຊື່

ແຜນທີ່  ການໃສ່ເຄື່ ອງໝາຍແຜນທີ່  ການໃສ່ທິ ດເໜືອ ການໃສ່ມາດຕາສ່ວນແຜນທີ່ ດ່ັງນີ ້

ເປັນຕ້ົນ 
 
 
 
 
 
 
 
 
 

Data View ສໍ າຫັຼບສະແດງຂໍ ້ ມູນ  
Layout View ສໍ າຫັຼບສະແດງແຜນທີ່  ຫືຼ ແມ່ແບບຕ່າງຂອງແຜນທີ່  
Template  
Graphs ສໍ າຫັຼບສະແດງກຣາຟຂອງແຜນທີ່   
Reports ສໍ າຫັຼບສ້າງລາຍງານຂໍ ້ ມູນແບບຕາຕະລາງ  
Data Frame Properties.. ສໍ າຫັຼບກໍານົດຄຸນສົມບັດການສະແດງຜົນຢູ່ໜ້າ
ຈໍ ເຊັ່ ນ ກໍານົດຫົວໜ່ວຍທີ່ ໃຊ້ໃນການວັດ ລະບົບພິກັດ ມາດຕາສ່ວນ 
ເສ້ັນກຣີ ດ 
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Data Frame ສ້າງຂອບຂໍ ້ ມູນໃໝ່  
Title ສ້າງຊື່ ແຜນທີ່  ຫຼື  ຫົວຂໍ ້ ຂອງແຜນທີ່   
Text ສ້າງຄໍ າອະທິບາຍຕ່າງໆໃນແຜນທີ່   
Dynamic Text ສ້າງເລກໜ້າ ຊື່  ແລະອື່ ນໆ ໂດຍການເລື ອກຟິວ ຫຼື  ຖັນຂໍ ້ ມູນທີ່ ຕ້ອງການສະແດງ ກໍ
ຈະປ່ຽນແປງຕາມຂໍ ້ ມູນທີ່ ຖືກເລື ອກ  
Neatline… ສ້າງຂອບອ້ອມຮອບຂອງແຜນທີ່  
Legend… ສ້າງສັນຍະລັກ ຫຼື  ຄໍ າອະທິບາຍແຜນທີ່   
North Arrow… ສ້າງທິດເໜືອແຜນທີ່   
Scale Bar… ສ້າງມາດຕາສ່ວນແຜນທີ່ ແບບບັນທັດ  
Scale Text…ສ້າງມາດຕາສ່ວນແຜນທີ່ ແບບຕົວອັກສອນ ຫຼື  ຕົວເລກ  
Picture…ນໍ າເຂົ ້ າຮູບພາບເພ່ືອປະກອບໃສ່ແຜນທີ່   
Object…ນໍ າເຂົ ້ າສິ່ ງອື່ ນໆເພື່ ອປະກອບໃສ່ແຜນທີ່  
 
ເມນູ Selection ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ   

 
Select By Attributes ໃຊ້ສໍ າຫັຼບຄ້ົນຫາຂໍ ້ ມູນຈາກຕາຕະລາງແບບມີເງື່ ອນໄຂກໍານົດໃນຮູບແບບ 
SQL 
Select By Location ໃຊ້ສໍ າຫັຼບຄ້ົນຫາຂໍ ້ ມູນພ້ືນທີ່ ທາງຕໍາແໜ່ງ 
 
 
ເມນູ Geoprocessing ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ ການສ້າງຂອບເຂດໄລຍະ
ຫ່າງ ການຕັດຂໍ ້ ມູນ ການຊ້ອນທັບ ການລວມຂໍ ້ ມູນດ່ັງນີ ້ ເປັນຕ້ົນ   
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Buffer ໃຊ້ສໍ າຫັຼບສ້າງແນວລະຍະຫ່າງຕາມເງື່ ອນໄຂທີ່ ກໍານົດ ແລະສ້າງເປັນຊ້ັນຂໍ ້ ມູນໃໝ່ໃຫ້ພອ້ມ  
Clip ໃຊ້ສໍ າຫັຼບຕັດຂໍ ້ ມູນສະເພາະພ້ືນທີ່ ທີ່ ສົນໃຈ ແລະສ້າງເປັນຊ້ັນຂໍ ້ ມູນໃໝ່ໃຫ້ພອ້ມ 
Intersect ໃຊ້ສໍ າຫັຼບຊ້ອນທັບຂໍ ້ ມູນຕ້ັງແຕ່ 2 ຊ້ັນຂໍ ້ ມູນຂຶ ້ ນໄປ ແລະສ້າງເປັນຊ້ັນຂໍ ້ ມູນໃໝ່ໃຫ້ພອ້ມ 
Union ໃຊ້ສໍ າຫັຼບການເລື ອກພ້ືນທີ່ ທັງໝົດເພ່ືອເຮັດການລວມຂໍ ້ ມູນ  
Merge ໃຊ້ສາํຫັຼບການລວມຂໍ ້ ມູນເຂົ ້ າກັນເປັນອັນດຽວ ແລະສ້າງເປັນຊ້ັນຂໍ ້ ມູນໃໝ່ໃຫ້ພອ້ມ  
Dissolve ໃຊ້ສໍ າຫັຼບການລວມຂໍ ້ ມູນທີ່ ຄ້າຍຄື ກັນເຂົ ້ າເປັນອັນດຽວ ແລະສ້າງເປັນຊ້ັນຂໍ ້ ມູນໃໝ່
ໃຫ້ພອ້ມ   
Search for Tool ໃຊ້ສໍ າຫັຼບຄ້ົນຫາເຄື່ ອງມື ທີ່ ຕ້ອງການໃຊ້ງານໂດຍຂຽນຄໍ າສ່ັງທີ່ ຕ້ອງການໃຊ້ງານ  
ArcToolbox ໃຊ້ສໍ າຫັຼບເປີ ດເຄື່ ອງມື ຕ່າງໆສໍ າຫັຼບເພ່ືອວິ ເຄາະຂໍ ້ ມູນ  
Environments…ໃຊ້ສໍ າຫັຼບກໍານົດຕໍາແໜ່ງທີ່ ຢູ່ Folder ທີ່ ກໍາລັງເຮັດວຽກໃນປັດຈຸບັນ  
ModelBuilder ໃຊ້ສໍ າຫັຼບສ້າງແຜນຜັງ ແລະສ້າງຊຸດຄໍ າສ່ັງພາສາ Python  
Python ໃຊ້ສໍ າຫັຼບການຂຽນໂປຣແກຣມເພ່ີມເຕີ ມ 
 
ເມນູ Customize ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ ໂປຣແກຣມເສີ ມ ກຸ່ມເຄື່ ອງມື
ຕ່າງໆ ດ່ັງນີ ້ ເປັນຕ້ົນ  

 
 
Toolbars ໃຊ້ສໍ າຫັຼບເລື ອກໃຊ້ງານເຄື່ ອງມື ຕ່າງໆ  
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Extensions… ໃຊ້ສໍ າຫັຼບອະນຸຍາດເປີ ດໃຊ້ງານໂປຣແກຣມເສີ ມ 
Add In Manager…ໃຊ້ສໍ າຫັຼບການກໍານົດແຫ່ຼງທໍາງານຂອງ ArcGIS ແບບອອນໄລ  
Customize Mode… ໃຊ້ສໍ າຫັຼບສ້າງເຄື່ ອງມື  ຫຼື  ຄໍ າສ່ັງ ປຸ່ມຄໍ າສ່ັງ ດ້ວຍຕົວ 

 
ເມນູ Windows ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ ເປີ ດປິ ດເຄື່ ອງມື TOC ເປີ ດປິ ດ 
ArcCatalog ດ່ັງນີ ້ ເປັນຕ້ົນ  
 

 
Overview ໃຊ້ສໍ າຫັຼບສະແດງຂອບເຂດຂໍ ້ ມູນແບບເບິ່ ງເຫັນໄດ້ທັງໝົດໂດຍລວມ  
Magnifier ໃຊ້ສໍ າຫັຼບຂະຫຍາຍຂໍ ້ ມູນເພ່ືອເບິ່ ງລາຍລະອຽດພື ້ ນທີ່ ທີ່ ສົນໃຈ  
Table of Contents ໃຊ້ສໍ າຫັຼບເປີ ດໜ້າຈໍ ລາຍການສາລະບານຂໍ ້ ມູນ  
Catalog ໃຊ້ສໍ າຫັຼບເປີ ດໂປຣແກຣມ ArcCatalog  
Search ໃຊ້ສໍ າຫັຼບຂຽນເພ່ືອຄ້ົນຫາເຄື່ ອງມື ຕ່າງ  
Image Analysis ໃຊ້ສໍ າຫັຼບວິ ເຄາະຂໍ ້ ມູນທາງຣີ ໂມດເຊນຊິ ງ ຫຼື  ພາບຣາສເຕີ Raster ໂດຍມີເຄື່ ອງມື
ຕ່າງໆເຊັ່ ນ Stretch, Resample, Filtering ເປັນຕ້ົນ 

 
ເມນູ Help ເປັນກຸ່ມຄໍ າສ່ັງທີ່ ບັນຈຸລາຍການຍ່ອຍຕ່າງໆເຊັ່ ນ 

 
 
ArcGIS Desktop Help ໃຊ້ສໍ າຫັຼບເພ່ືອເປີ ດອ່ານຄູ່ມື ການໃຊ້ງານໂປຣແກຣມ ມີ ປະໂຫຍດຢ່າງ
ຍິ່ ງໃນການໃຊ້ງານໂປຣແກຣມເວີ ເຊັນໃໝ່ເປັນຕ້ົນ  
ArcGIS Resource Center ໃຊ້ສໍ າຫັຼບສຶ ກສາເພ່ີມເຕີ ມຈາກເວັບໄຊທາງບໍ ລິ ສັດ ESRI  

 ປຸ່ມຄໍ າສ່ັງມາດຕະຖານ (Standard Toolbar) 

ປຸ່ມຄໍ າສ່ັງມາດຖານ (Standard Toolbar) ລວມມີທັງໝົດ 17 ປຸ່ມເຄື່ ອງມື  ຊຶ່ ງມັນຄວບຄຸມເອົ າ 
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ເຄື່ ອງມື ທີ່ ສໍ າຄັນຂອງການຈັດການກັບຊ້ັນຂໍ ້ ມູນແຜນທີ່  ໃນນํາໃຊ້ກອ່ນອື່ ນໝົດເຮົ າຕອ້ງກົດປຸ່ມ
ຟັງຊັນ ດ່ັງກ່າວ ຊຶ່ ງສະແດງລາຍລະອຽດດ່ັງນີ ້  

 

ປຸ່ມ ຊື່  ການໃຊ້ງານ 

 New ສ້າງແຜນທີ່ ໃໝ່ 

 Open ເປີ ດແຜນທີ່ ທີ່ ມີ ຢູ່ແລ້ວ 

 Save ບັນທຶກແຜນທີ່  

 Print ພິມແຜນທີ່  

 Cut ຕັດຊ້ັນຂໍ ້ ມູນ 

 Copy ສໍ າເນົາຊ້ັນຂໍ ້ ມູນ 

 Paste ວາງຊ້ັນຂໍ ້ ມູນ 

 Delete ລຶ ບຊ້ັນຂໍ ້ ມູນທີ່ ຖື ກເລື ອກ 

 Undo ໃຊ້ສໍ າຫັຼບການຢອ້ນກັບການທໍາງານທີ່ ເຮົ າ
ທໍາງານໃນຄ້ັງລ່າສຸດ 

 Redo ໃຊ້ສໍ າຫັຼບການຢອ້ນກັບທີ່ ໃຊ້ຄໍ າສ່ັງ Undo  

 Add Data ເພ່ີມຊ້ັນຂໍ ້ ມູນແຜນທີ່  

 Scale ກໍານົດການສະແດງມາດຕາສ່ວນ 

 Editor Toolbar ເຄື່ ອງມື ແກ້ໄຂແຜນທີ່  

 ArcCatalog ເອີ ້ ນໃຊ້ໂປຣແກຣມ ArcCatalog 

 Show/Hide ArcToolbox 
Window 

ສະແດງຫຼື ເຊື່ ອງຊອ້ນໜ້າຈໍ ArcToolbox 

 Show/Hide Command 
Line Window 

ສະແດງຫຼື ເຊື່ ອງຊອ້ນໜ້າຈໍ  Command  

 Start Model Builder ເຄື່ ອງມື ສໍ າຫັຼບວິ ເຄາະຂໍ ້ ມູນດວ້ຍ Model 
Builder 

 What’s This ຕົວຊ່ວຍອະທິບາຍໃນການນໍ າໃຊ້ເຄື່ ອງມື
ຕ່າງໆ 
 

2.3. ການນໍ າຂໍ ້ ມູນເຂົ ້ າໃນ Arc Map  

   ແມ່ນການນໍ າຂໍ ້ ມູນທີ່ ເຮົ າຈະເອົ າມາໃຊ້ໃນການສ້າງແຜນທີ່  ຂໍ ້ ມູນເຫ່ົຼານ້ັນຕ້ອງເປັນຂໍ ້ ມູນທີ່ ເປັນ 
Vector ຫຼື  Raster. ມີ ນາມສະກຸນເປັນ Shapefile (.shp), Image (.img), TIFF (.tif),….ອື່ ນໆ 

ໝາຍເຫດ: ກໍລະນີ ຖ້າລົງໂປຣແກລມໃໝ່ຊ່ອງທີ່ ເຮົ າເກັບຂໍ ້ ມູນໄວ້ຈະບໍ່ ເຫັນເຮົ າຕ້ອງໄດ້ເຊື່ ອມຕ່ໍ
ເຂົ ້ າກັບຊ່ອງຂໍ ້ ມູນນ້ັນກ່ອນ.  
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 ວິ ທີ ການ: 
1. ຄິ ກເມົາທີ່  Add Data 
2. ແລ້ວຄິ ກ Connect to folder 
3. ເລື ອກຊ່ອງຂໍ ້ ມູນທີ່ ຈະເຊື່ ອມຕ່ໍ (ຊ່ອງທີ່ ເກັບຂໍ ້ ມູນ Shapefile ໄວ້) ແລ້ວ ກົດ OK 

 

 

 

 

 

 

 

 

 

 ວິ ທີ  1 
1. ຄິ ກເມົາທີ່  Add Data  
2. ແລ້ວເລື ອກຊ່ອງທີ່ ເກັບຂໍ ້ ມູນໄວ້ ທີ່ ເປັນຂໍ ້ ມູນ Shapefile (.shp) 
3. ເລື ອກຂໍ ້ ມູນແລ້ວຄິ ກ Add 

 
 

 

 

 

 

 

 

 

1

2

3

1

2

3



18 
 

 ວິ ທີ  2 
1. ຄິ ກຂວາທີ່  Layers 
2. ຄິ ກເມົາທີ່  Add Data 
3. ແລ້ວເລື ອກຊ່ອງທີ່ ເກັບຂໍ ້ ມູນໄວ້ ທີ່ ເປັນຂໍ ້ ມູນ Shapefile (.shp) 
4. ເລື ອກຂໍ ້ ມູນແລ້ວຄິ ກ Add 

 

 

 

 

 

 

 

 

2.4. ການນໍ າເຂົ ້ າຂໍ ້ ມູນຈາກຕາຕາລາງທີ່ ບັນທຶກຄ່າ XY ຈາກ Excel  

1. ປ້ອນຂໍ ້ ມູນຄ່າ XY ໃສ່ຕາຕາງ Excel  
2. ເຂົ ້ າ Add Data ແລ້ວເລື ອກຊ່ອງເກັບຂໍ ້ ມູນທີ່ ເກັບໄຟລໄວ້, ເລື ອກຂໍ ້ ມູນ Excel ແລ້ວ Add 
3. ຈາກນ້ັນຄິ ກຂາວໃສ່ຊ້ັນຂໍ ້ ມູນ Excel ທີ່ ມັນສະແດງ ແລ້ວ ເຂົ ້ າທີ່  Display XY Data 

 

 

 

 

 

 

 

1 

2

3

4 
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1

2
ເຮົ າຈະເຫັນໄຟລ 

Excel ຂື ້ ນມາ  

3
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4. ທີ່ ຫ້ອງ Choose table from the map or brown for another table ເປີ ດຂໍ ້ ມູນ Excel ທີ່

ເຮົ າບັນທຶກ 
 ຫ້ອງ X Field ເລື ອກເປັນ X 
 ຫ້ອງ Y Field ເລື ອກເປັນ Y  
5. ເລື ອກ Projected ໃຫ້ຂໍ ້ ມູນຂອງເຮົ າ 
 ຄີ ກທີ່   Edit 

 

 

 

 

 

 ຈະປະກົດໜ້າໃໝ່ຂື ້ ນມາເລື ອກ Projected Coordinate system  >> UTM >> WGS 
1984 >> Northern Hemisphere >> WGS 1984 UTM Zone 48N. 

 ແລ້ວກົດປຸ່ມ OK >> OK 

 

 

 

 

 

 

 

 

 

 

 

ຂໍ ້ ມູນຈຸດທີ່ ເຮົ າໃສ່

Projection ແລ້ວກໍ

ຈະສະແດງຂື ້ ນມາ  
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6. ເຮົ າກ່ໍຈະໄດ້ຂໍ ້ ມູນມາສະແດງດ່ັງຮູບຂ້າງເທິງນີ ້  ຫັຼງຈາກນ້ັນເຮົ າກ່ໍສ່ົງອອກຂໍ ້ ມູນໃຫ້ເປັນ 
Shape file  

2.5. ວິ ທີ ການສ່ົງອອກໄປເປັນແຟ້ມຂໍ ້ ມູນ Shapefile  

1) ກົດຂວາຊ້ັນຂໍ ້ ມູນທີ່ ເຮົ າໃສ່ Projection ແລ້ວ ຫຼື  ຊ້ັນຂໍ ້ ມູນອື່ ນໆທີ່ ຕ້ອງການສ່ົງອອກ ແລ້ວ
ເລື ອກລາຍການ Data 

2) ຈາກນ້ັນກົດເລື ອກຄໍ າສ່ັງ Export Data ຈະປາກົດໜ້າຈໍ  Export Data 
3) ໃຫ້ເລື ອກຊ່ອງ Output shapefile ເພ່ືອບັນທຶກຂໍ ້ ມູນໃໝ່ 
4) ແລ້ວໃສ່ຊື່ , ກົດປຸ່ມ Save ແລະ OK ສິ ້ ນສຸດການສ້າງຂໍ ້ ມູນ GIS ຈາກຖານຂໍ ້ ມູນ GPS 

 
 
 

 

 

 

 

 

 

 

 

 

 

2.6. ການເບິ່ ງຂໍ ້ ມູນຕາຕະລາງຈາກ Attribute table 

   ແມ່ນການເຂົ ້ າໄປຈັດການກ່ຽວກັບລາຍລະອຽດຂໍ ້ ມູນຂອງຊ້ັນຂໍ ້ ມູນເຮົ າ ເພື່ ອແກ້ໄຂ, ປັບປຸງ 
ແລະ ອື່ ນໆ 

- ວິ ທີ ການ  

1

2

3

4
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1) ຄິ ກຂວາໃສ່ຊ້ັນຂໍ ້ ມູນທີ່ ເຮົ າຕ້ອງການເບິ່ ງຕາຕະລາງ ແລ້ວເຂົ ້ າໄປທີ່  Open 
Attribute Table 

2) ເຮົ າກໍຈະເຫັນໜ້າຕ່າງຂອງຕາຕະລາງຂື ້ ນມາ, ຈະເຫັນມີ ລາຍລະອຽດຂອງຂໍ ້ ມູນ
ຕ່າງສະແດງຢູ່ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 ການເຮັດວຽກກັບຂໍ ້ ມູນຕາຕະລາງຈາກ Attribute table 
   ແມ່ນການເຂົ ້ າໄປຈັດການກ່ຽວກັບລາຍລະອຽດຂໍ ້ ມູນຂອງຊ້ັນຂໍ ້ ມູນເຮົ າ ເພື່ ອແກ້ໄຂ, ປັບປຸງ,.....
ອື່ ນໆ 

- ວິ ທີ ການ  
3) ຄິ ກຂວາໃສ່ຊ້ັນຂໍ ້ ມູນທີ່ ເຮົ າຕ້ອງການເບິ່ ງຕາຕະລາງ ແລ້ວເຂົ ້ າໄປທີ່  Open 

Attribute Table 
4) ເຮົ າກໍຈະເຫັນໜ້າຕ່າງຂອງຕາຕະລາງຂື ້ ນມາ, ຈະເຫັນມີ ລາຍລະອຽດຂອງຂໍ ້ ມູນ

ຕ່າງສະແດງຢູ່ 
 

1

2
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 ການເລື ອກເອົ າສະເພາະຂໍ ້ ມູນໃນຕາຕະລາງ (Selected by Attribute) 
1. ເລື ອກ Selected by Attribute 
2. ເລື ອກປະເພດຂໍ ້ ມູນທິີ

່ ຕ້ອງການ 
3. ເລື ອກຂໍ ້ ມູນທີ່ ຕ້ອງການ ແລ້ວ ກົດ Apply 
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 ການເພ່ີມຖັນໃນຕາຕະລາງ 
1. ເຂົ ້ າໄປທີ່  Table Options > Add Field 
2. ໃສ່ຊື່  ແລະ ເລື ອກປະເພດຂອງຖັນຂໍ ້ ມູນ (short integer, long integer, float, double, 

text, date) 
3. ກົດ ok 

ໝາຍເຫດ: ເຮົ າສາມາດເພີ່ ມຖັນຮູບແບບຂໍ ້ ມູນເປັນໂຕເລກ ຫຼື  ໂຕໜັງສື ກໍໄດ້ 
 
 
 
 
 
 
 
 
 
 

 

ຕົວຢ່າງ: ການເພີ່ ມຖັນເພ່ືອຄໍ ານວນເນື ້ ອທີ່  

1. ເຂົ ້ າໄປທີ່  Table Options > Add Field 
2. ໃສ່ຊື່  ແລະ ເລື ອກປະເພດຂອງຖັນຂໍ ້ ມູນເປັນdouble 
3. ກົດ ok 
4. ເມື່ ອໄດ້ຖັນໃໝ່ແລ້ວ ຄິ ກຂາວໃສ່ຫົວຖັນ > Calculate Geometry 
5. ເລື ອກປະເພດ Units 
6. ກົດ OK 
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2.7. ການຕັດຂໍ ້ ມູນ ແລະ ປັບແຕ່ງຊ້ັນຂໍ ້ ມູນ 

   ການຕັດຂໍ ້ ມູນແມ່ນການທີ່ ເຮົ າຈະກໍານົດເອົ າສະເພາະພ້ືນທີ່ ໆເຮົ າຕ້ອງການ ເຊັ່ ນ ຂອບເຂດ
ແຂວງ, ເມື ອງ, ບ້ານ, ເສ້ັນທາງ, ສາຍນໍ ້ າ,......ອື່ ນໆ. 

 ວິ ທີ ການ 1 
1. ຄິ ກເມ້ົາທີ່  ArcToolbox 
2. ແລ້ວເລື ອກ Analysis Tools > Extract > Clip  
3. Input Features ແມ່ນເລື ອກຂໍ ້ ມູນທີ່ ເຮົ າຈະຕັດ 
4. Clip Features ແມ່ນເລື ອກຂອບເຂດທີ່ ເຮົ າຕ້ອງການຕັດ ໃນຂອບເຂດນ້ັນ 
5. Output Feature Class ແມ່ນເລື ອກຊ່ອງເກັບຂໍ ້ ມູນ ທີ່ ເຮົ າຕ້ອງການເກັບຂໍ ້ ມູນທີ່ ຈະຕັດໄວ້ 
6. ຖ້າແລ້ວ ກົດ OK 
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 ວິ ທີ ການ 2 
 ຄິ ກເມ້ົາທີ່  Geoprocessing 
 ເລື ອກ Clip 
 ຈາກນ້ັນເຮັດຕາມ ວິ ທີ ການ 1 ຂ້ັນຕອນ ແຕ່ 3-6 

 
 

 

 

 

 

 

 

 

 

 

12

3 4

5

6

1

2
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 ການຕ່ໍຊ້ັນຂໍ ້ ມູນ (Merge) 
1. ເຂົ ້ າໄປທີ່  Geoprocessing > Merge 
2. ເລື ອກຊ້ັນຂໍ ້ ມູນທີ່ ຕ້ອງການຕ່ໍ 
3. ເລື ອກບ່ອນບັນທຶກຊ້ັນຂໍ ້ ມູນໃໝ່ > OK 

 
 

 

 

 

 

 

 

5.ການສ້າງຕາຕະລາງ Attribute Table 

1. ເປີ ດໂປລແກລມ Excel ຂື ້ ນມາ 
2. ກໍານົດຫ້ອງຂໍ ້ ມູນຕ່າງໆທີ່ ຕ້ອງການ ໂດຍສະເພາະຂໍ ້ ມູນ ລະຫັດ ລໍ າດັບ, ຈຸດຈີ ພີເອັສ, 

ປະເພດ, ວັນທີ , ຊື່ ຂໍ ້ ມູນ, ການຖື ຄອງ, ອາຍຸການປູກ ແລະ ລາຍລະອຽດອື່ ນໆຕາມທີ່

ຕ້ອງການ..... 

ເປັນພຽງຕົວຢ່າງໃນການທີ່ ເຮົ າຈະສ້າງຕາຕະລາງຂອງຖານຂໍ ້ ມູນທີ່ ຈະນໍ າໃຊ້ເຂົ ້ າໃນການເຮັດ
ແຜນທີ່ ປ່າປູກ ສ່ວນຮູບແບບໃນການເຮັດຕົວຈິ ງແມ່ນເຮົ າສາມາດປັບປ່ຽນໄປຕາມຮູບແບບ
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ຂອງໜ້າວຽກທີ່ ເໝາະສົມ. (ໝາຍເຫດ: ສ່ວນວິ ທີ ການນໍ າເຂົ ້ າຂໍ ້ ມູນໄປສູ່ການເຮັດແຜນທີ່ ແມ່ນ
ໄດ້ນໍ າສະເໜີຢູ່ ຫົວຂໍ ້  ການນໍ າເຂົ ້ າຂໍ ້ ມູນຈາກຕາຕະລາງການບັນທຶກຄ່າ XY ໃນ Excel). 

2.8. ການຕົບແຕ່ງແຜນທີ່  

   ການຕົບແຕ່ງແຜນທີ່  ແມ່ນຂະບວນການສຸດທ້າຍຫລັງຈາກທີ່ ເຮົ າໄດ້ນໍ າເຂົ ້ າຂໍ ້ ມູນ ແລະ ດັດແກ້
ຂໍ ້ ມູນທີ່ ເຮົ າຕ້ອງການສໍ າເລັດແລ້ວ ແລະ ກ່ອນທີ່ ເຮົ າຈະຕຽມສ່ົງແຜນທີ່ ນ້ັນອອກໄປເປັນໂຕ
ສໍ າເລັດຮູບ ເຊັ່ ນ: ການນํາເອົ າເຄື່ ອງໝາຍສັນຍາລັກຕ່າງໆຂອງແຜນທີ່ ນ້ັນເຂົ ້ າ: ຊື່ , ມາດຕາສ່ວນ 
ແລະ ອື່ ນໆ.  

 ວິ ທີ ການ 
1. ຄິ ກເມ້ົາທີ່  View ແລ້ວເລື ອກ Layout View 
2. ການເລື ອກສັນຍາລັກໃສ່ແຜນທີ່  ເຂົ ້ າໄປ Insert ແລ້ວເລື ອກ  

 Title ແມ່ນຫົວຂໍ ້ ຊື່ ຂອງແຜນທີ່  
 Text ແມ່ນເພ່ີມຂໍ ້ ຄວາມໂຕໜັງສື  
 Legend ແມ່ນສະແດງເຄື່ ອງໝາຍແຜນທີ່  
 North Arrow ແມ່ນສະແດງສັນຍາລັກທິ ດເໜືອ 
 Scale Bar ແມ່ນສະແດງສັນຍາລັກມາດຕາສ່ວນເປັນເສ້ັນຊື່  
 Scale Text ແມ່ນສະແດງສັນຍາລັກມາດຕາສ່ວນເປັນໂຕເລກ 

 
 

 

 

 

 

 

 

 

 

ຂໍ ້ ແນະນໍ າ: ສັນຍາລັກ ຫຼື  ເຄື່ ອງໝາຍທີ່ ກ່າວມາຂ້າງເທິ ງນ້ັນເປັນໂຕພ້ືນຖານຂອງແຜນທີ່ , ໃນ
ການໃສ່ສັນຍາລັກ ຫຼື  ເຄື່ ອງໝາຍຕ່າງໆນ້ັນບາງສັນຍາລັກຈະໃສ່ ຫຼື  ບໍ່ ໃສ່ກໍໄດ້ ຂື ້ ນກັບຄວາມ
ຕ້ອງການຂອງຜູ້ທີ່ ສ້າງ ຫຼື  ວຽກງານທີ່ ຈະເຮັດ. 

1

2
Layer view 
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2.9. ການສ່ົງອອກແຜນທີ່  

   ແມ່ນການທີ່ ຈະນໍ າແຜນທີ່ ໆເຮົ າສ້າງໄວ້ຫລັງຈາກຕົບແຕ່ງແລ້ວໆ ກຽມສ່ົງອອກໄປເປັນຂໍ ້ ມູນ
ຮູບພາບ ແລະ ເອົ າໄປນໍ າໃຊ້ຕົວຈິ ງ. 

 ວິ ທີ ການ 
1. ຄິ ກເມ້ົາໄປທີ່  File ແລ້ວເລື ອກ Export Map 
2. ເລື ອກຊ່ອງທີ່ ເຮົ າຕ້ອງການເກັບຂໍ ້ ມູນນ້ັນໄວ້ 
3. ໃສ່ຊື່ ທີ່ ຫ້ອງ File name 
4. Save as type ເລື ອກປະເພດນາມສະກຸນແຜນທີ  (ສ່ວນຫລາຍຈະໃຊ້ເປັນ JPEG) 
5. ແລ້ວກົດ Save 

 

 

 

 

 

 

 

 

 

 

2.10. ການນໍ າໃຊ້ GPS 

 ຂໍ ້ ມູນພ້ືນຖານກ່ຽວກັບ GPS 

GPS – Global Positioning System (ລະບົບແຈ້ງຈຸດພິກັດຢູ່ເທິ ງໜ້າໂລກ) ເປັນເຄື່ ອງຮັບ
ສັນຍານດາວທຽມ ເພ່ືອຄໍ ານວນຫາຕໍາແໜ່ງ (ພິກັດ) ບ່ອນທີ່ ເຄື່ ອງ ຈີ ພີເອັສຢູ່. ລະບົບດ່ັງກ່າວ
ແມ່ນຖື ກພັດທະນາໂດຍກອງທັບສະຫະລັດອາເມລິ ກາໄດ້ຫຼາຍສິ ບປີ ຜ່ານມາ ຊຶ່ ງເມື່ ອກ່ອນໄດ້ນໍ າໃຊ້
ເຂົ ້ າໃນວຽກງານທະຫານ. ປະຈຸບັນໄດ້ນໍ າເຂົ ້ າມານໍ າໃຊ້ໃນວຽກງານພົນລະເຮື ອນຫຼາຍໆຢ່າງທີ່ ກ່ຽວ
ຂ້ອງກັບຕໍາແໜ່ງ (ຄ່າພິກັດ), ແຜນທີ່  ແລະ ວຽກງານສໍ າຫຼວດ. 

 GPS ມີ ຄວາມຊັດເຈນຫລາຍປານໃດ? 

1

2

3

4

5
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ຄວາມຊັດເຈນແມ່ນຂຶ ້ ນກັບ ຊະນິ ດ, ປະເພດຂອງ GPS ແລະ ປັດໄຈຕ່າງໆຄື : 

 ຈໍ ານວນສັນຍານຈາກດາວທຽມ 26 ໜ່ວຍທີ່ ໂຄຈອນຢູ່ຮອບໂລກ (ຢ່າງນ້ອຍຕ້ອງມີ ສັນ
ຍານການຮັບຈາກດາວທຽມ 3 ຫາ 4 ໜ່ວຍ ເພ່ືອການກວດແກ້ຄ່າຄວາມຜິດພາດກ່ຽວກັບ
ທີ່ ຕ້ັງ) 

 ມີ ລະບົບກວດແກ້ຄວາມຜິດພາດ (differential GPS or DGPS) 

 ເວລາໃນການຄໍ ານວນຫາຕໍາແໜ່ງ (ການຈັບຈຸດໃດໜ່ຶງ ຈະໃຊ້ເວລາຢ່າງນ້ອຍປະມານ 2-3 
ນາທີ ) 

 ນໍ າໃຊ້ຄ່າສະເລ່ຍດ້ວຍການແທກຕໍາແໜ່ງຫລາຍຄ້ັງ 

 ປັບແກ້ຕົວເລກ ທີ່ ມີ ການຄໍ ານວນຜິດພາດ ເຊັ່ ນ: ລວງສູງຈາກລະດັບນໍ ້ າທະເລ (elevation) 

 

 ການຮັບສັນຍານຂອງເຄື່ ອງຈີ ພີເອັສ 

 ທ້ອງຟ້າປອດໂປ່ງ ເພາະວ່າເຄື່ ອງ GPS ຮັບສັນຍານຈາກດາວທຽມທີ່ ໂຄຈອນອ້ອມໂລກ 
ເສົ າອາກາດຂອງເຄື່ ອງ GPS ຈະຕ້ອງບໍ່ ມີ ສິ່ ງກີ ດຂວາງຢູ່ທ້ອງຟ້າ ຊຶ່ ງຈະເຮັດໃຫ້ເຄື່ ອງຈີ ພີ
ເອັສ ເລື ອກຮັບສັນຍານຈາກດາວທຽມທີ່ ມີ ຢູ່ໃກ້ໄດ້ງ່ າຍ. 

 ຂໍ ້ ຈໍ າກັດ 

- ການເຄື່ ອນຍ້າຍຂອງສັນຍານດາວທຽມທີ່ ຊັກຊ້າແມ່ນມີ ຜົນມາຈາກກຸ່ມເມກທີ່ ຕຶບໜາ
ເຊິ່ ງກີ ດຂ້ັນ ສັນຍານ. 

- ການບັນທຶກຈຸດພິກັດຖ້າຫາກວ່າທ້ອງຟ້າບໍ່ ປອດໂປ່ງ (ມີ ຜາ ຫຼື  ຕຶກອາຄານ, ປ່າຕຶບໜາ ຫຼື  
ສິ່ ງກີ ດຂວາງອື່ ນໆ) ສັນຍານດາວທຽມຈະຖື ກກີ ດຂວາງ ແລະ ຈະເຮັດໃຫ້ຄວາມສາມາດຂອງ
ເຄື່ ອງ GPS ຫລຸດຜ່ອນຄວາມແນ່ນອນຂອງຂໍ ້ ມູນໄດ້ ແລະ ໃຊ້ເວລາໃນການຄໍ ານວນຕໍາແ
ໜ່ງດົນກ່ວາປົ ກກະຕິ 

- ຄວາມຜິດພາດກ່ຽວກັບຄ່າຂອງຕໍາແໜ່ງແມ່ນສາມາດເກີ ດຂື ້ ນໄດ້ຈາກສະພາບ
ການແຈກຢາຍທີ່ ບໍ່  ເໝາະສົມຂອງບັນດາດາວທຽມທີ່ ເຄື່ ອງ GPS ສາມາດຮັບເອົ າສັນຍານ
ນ້ັນ. 

 

 ໜ້າທີ່ ຂອງ GPS (ເຄື່ ອງ GPS ສາມາດນໍ າໃຊ້ເຮັດຫຍັງໄດ້ແນ່) 

 ບັນທຶກຈຸດທີ່ ສົນໃຈ 

 ບັນທຶກໍາເສ້ັນທາງຂອງການເດີ ນທາງ 

 ຕິດຕາມໄປຫາຈຸດທີ່ ເຮົ າສົນໃຈ 
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 ບອກຄ່າຕໍແໜ່ງທີ່ ຢື ນຢູ່ໃນປະຈຸບັນ ເຊິ່ ງຊ່ວຍໃນການຊອກທີ່ ຕ້ັງຂອງຕົນເອງຢູ່ເທິ ງ
ແຜນທີ່  

 ວັດແທກໄລຍະທາງຈາກຈຸດທີ່ ຕ້ັງປະຈຸບັນຫາຈຸດທີ່ ສົນໃຈ 

 ຄິ ດໄລ່ເນື ້ ອທີ່ ຂອງການບັນທຶກຕາມເສ້ັນທາງ 

 

 ພາບລວມຂອງເຄື່ ອງ GPS Garmin GPS map 62s 
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 ການນໍ າໃຊ້ປຸ່ມຕ່າງໆ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ບັນດາໜ້າຕ່າງໆຂອງເຄື່ ອງ GPS 

ບັນດາໜ້າຫັຼກທີ່ ສະແດງເຮົ າສາມາດເພ່ີມ ຫຼື  ປັບປ່ຽນໄດ້, (ສະເພາະໃນຄູ່ມື ທີ່ ນໍ າມາມີ ທັງໝົດ 
5 ໜ້າຫັຼກທີ່ ມານํາເຄື່ ອງ) 
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 ໜ້າຄິ ດໄລ່ການເດີ ນທາງ 

 

 

 

 
 

 

 

 

 ໜ້າສະແດງຄວາມສູງ 
 

 

 

 

 

 

 

 

 ໜ້າຄໍ າສ່ັງຕ້ົນຕໍ 
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 ໜ້າເຂັມທິດ 
 
 
 
 
 
 
 

 

 ໜ້າແຜນທີ່  
 
 
 
 
 
 
 
 

7. ການຕ້ັງຄ່າເຄື່ ອງ GPS	
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 ການຕ້ັງຄ່າການບັນທຶກຕາມທາງເດີ ນ 
 
 

 

 

 

 

 

 

 

 ການບັນທຶກຈຸດພິກັດ 

 ກົດປຸ່ມ MARK 

 ເພ່ືອຕອບຮັບຈຸດທີ່ ຖື ກບັນທຶກ ແລະ ບັນທຶກມັນໄວ້ໃນເຄື່ ອງເລື ອກເອົ າ DONE > OK  

 ຫຼື  ທາສີ ເອົ າຫ້ອງໃດກໍໄດ້ແລ້ວ ENTER ເພ່ືອປ່ຽນຄ່າຂອງຈຸດພິກັດ 

 ຫັຼງຈາກປ່ຽນແປງຄ່າແລ້ວ ເລື ອກ DONE ແລ້ວກົດ ENTER 
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 ການເອົ າຄ່າຈຸດພິກັດເຂົ ້ າເຄື່ ອງ 

 ກົດ MARK 

 ທາສີ ເອົ າຫ້ອງ Location > ENTER 

 ຂຽນຄ່າຂອງຈຸດພິກັດໃສ່ໂດຍນໍ າໃຊ້ຄີ ບອດເທິງໜ້າຈໍ  ເມື່ ອສໍ າເລັດແລ້ວ ເລື ອກ DONE 
ແລ້ວ ກົດ ENTER 

 

 

 

 

 

 

 

 

 ການດັດແກ້ຈຸດພິກັດ 

 ເຂົ ້ າໄປທີ່  Waypoint Manager 

 ແລ້ວເລື ອກຈຸດພິກັດທີ່ ຕ້ອງການຢາກຈະດັດແກ້ແລ້ວ ກົດ ENTER 

 ເລື ອກຫ້ອງທີ່ ຕ້ອງການຢາກດັດແກ້ ເມື່ ອແລ້ວໆ ກົດ OUIT 
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 ການລຶ ບຈຸດພິກັດ 

 ເຂົ ້ າໄປທີ່  Waypoint Manager 

 ແລ້ວເລື ອກຈຸດພິກັດທີ່ ຕ້ອງການລຶ ບແລ້ວ ກົດ ENTER 

 ກົດ MENU ແລ້ວເລື ອກ Delete > ກົດ ENTER  

 

 

 

 

 

 

 

 

 

 ການບັນທຶກເສ້ັນທາງ( Track) 
 ເຂົ ້ າໄປທີ່  Track Manager > Current Track > Enter > Save Track 
 ໃສ່ຊື່  ຫຼື  ຕ້ັງຄ່າຕາມຄວາມຕ້ອງການ > Done > Yes > Enter 
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 ການໃຊ້ຄໍ າສ່ັງ GoTo 

GoTo ແມ່ນໃຊ້ເພ່ືອການຕິດຕາມ ແລະ ຊອກຫາຈຸດທີ່ ເຮົ າສົນໃຈ. 

 ກົດປຸ່ມ FIND > Waypoints > ENTER > ເລື ອກຈຸດພິກັດທີ່ ຕ້ອງການຢາກຈະຕິດຕາມ > 
ENTER > GO 

 ກົດປຸ່ມ PAGE ເພ່ືອສະແດງໜ້າເຂັມທິດ (Compass) 

 ການວັດແທກໄລຍະທາງ 
 ຢູ່ໜ້າແຜນທີ່ , ກົດປຸ່ມ MENU 
 ທາສີ ເອົ າຄໍ າສ່ັງ Measure Distance > ENTER 
 ໃຊ້ປຸ່ມທິ ດທາງເພ່ືອເຄື່ ອນລູກ ສອນໄປຍັງຈຸດທີ່ ເລີ ້ ມວັດແທກ > ENTER 
 ເຄື່ ອນລູກສອນໄປຍັງຈຸດສຸດທ້າຍ > ENTER 
 ກົດ QUIT ເພ່ືອຍົກເລີ ກ 

 
 

 

 

 

 

 

 

 

 

 ການຄິ ດໄລ່ເນື ້ ອທີ່ ຈາກເຄື່ ອງ ຈີ ພີເອັສ 
 ກົດປຸ່ມ MENU ສອງເທື່ ອ > Area Calculation > ENTER 
 ກົດປຸ່ມ ENTER ເພ່ືອເລີ່ ມທໍາການວັດແທກແລ້ວເລີ່ ມຍ່າງຕາມພ້ືນທີ່ ໆຕ້ອງການຢາກ

ຄິ ດໄລ່ 
 ກົດປຸ່ມ ENTER ຫັຼງຈາກທີ່ ໄປເຖິງປາຍທາງແລ້ວ > Save Track ຖ້າຕ້ອງການຢາກ

ບັນທຶກໄວ້ > ENTER 
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ບົດທີ  3: ການນໍ າໃຊ້ Google Earth ເຂົ ້ າໃນການສ້າງແຜນທີ່  

 

1.ແຖບເມນູ (Menu Panel)   

2.ສ່ວນຄ້ົນຫາ (Search Panel)   

3.ລາຍການສະຖານທີ່  (Place Panel)   

4.ຕໍາແໜ່ງຫຼື ສະຖານທີ່ ໃຫ້ບໍ ລິ ການ(Layer Panel)   

5.ແຖບການສ້າງແລະລົບຂໍ ້ ມູນ (Make/Edit Panel)   

6.ເຄື່ ອງມື ຄວບຄຸມ (Tool Panel)    

7.ສ່ວນສະແດງແຜນທີ  (View Panel)   

8.ສ່ວນສະແດງລາຍລະອຽດຕໍາແໜ່ງ/ວັນຖ່າຍພາບ/ລະດັບຄວາມສູງ (Status) 

3.1. ການສ້າງຂໍ ້ ມູນ KML ໃນ google earth  

ເປັນການໃຊ້ເຄື່ ອງມື ຮູບຫຼາຍຫຼຽມ ໃນສ່ວນເຄື່ ອງມື ແຖບການສ້າງແລະລົບຂໍ ້ ມູນ (Make/Edit 
Panel) ເພ່ືອໃຫ້ຂໍ ້ ມູນທີ່ ສ້າງຂຶ ້ ນໃໝ່ບໍ່ ກະແຈກກະຈາຍ ຈຶ່ ງຈໍ າເປັນຕ້ອງສ້າງໂຟເດີ  ເພ່ືອເອົ າຂໍ ້ ມູນ
ເຂົ ້ າໄປເກັບມ້ຽນ 

1) ຄລີ ກຂວາໃສ່ My Please >> Add >> Folder  
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2) ໃສ່ຊື່  ໂຟເດີ  

3)ຄລີ ກໃສ່ ໂຟເດິ

ແລ້ວຄລີ ກໃສ່ 

4)ແຕ້ມອ້ອມພ້ືນ
ທີ່ ແລ້ວໃສ່ຊື່  
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3.2. ການບັນທຶກຂໍ ້ ມູນ KML  

ຫັຼງຈາກແຕ້ມຂໍ ້ ມູນຕາມທີ່ ຕ້ອງການແລ້ວ ຄລີ ກຂວາໃສ່ໂຟເດີ  ແລ້ວໄປ Save Place As 

 

 
 

2) ເລື ອກບ່ອນເກັບມ້ຽນ 

ແລ້ວໃສ່ຊື່ ຈາກນ້ັນກ່ໍ
ບັນທຶກ
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3.3. ການຂໍ ້ ມູນ KML ໃນ Arc map 

ການນໍ າຂໍ ້ ມູນຈາກ google earth ມາເປີ ດໃນ Arc map ເລີ່ ມຈາກການເປີ ດໂປຼແກມຂຶ ້ ນມາແລ້ວຄລີ ກໃສ່ 
Arc tools Box >> Conversion Tools >> KML To Layer  

 

 

ເລື ອກເອົ າຟາຍທີ່ ບັກທຶກຈາກ google 
earth ແລ້ວເລື ອກບ່ອນເກັບມ້ຽນ ແລ້ວ 
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3.4. ການ Convert ຂໍ ້ ມູນຈາກ Shapefile ໄປເປັນຂໍ ້ ມູນທີ່ ເປີ ດຢູ່ GoogleEarth  

 ຂ້ັນຕອນ 

1) ເປີ ດຊ້ັນຂໍ ້ ມູນທີ່ ຕ້ອງການ Convert  

2) ເຂົ ້ າ ArctoolBox > Conversion Tools > To KML > Layer to KML 

3) ຫ້ອງທີ່  1 (Layer) ເລື ອກຊ້ັນຂໍ ້ ມູນທີ່ ຕ້ອງການ Convert, ຫ້ອງທີ່  2 (Output file) 
ເລື ອກບ່ອນທີ່ ຈະເກັບຂໍ ້ ມູນ  

4) OK 

5) ຫັຼງຈາກນ້ັນໄປເປີ ດ File ຂໍ ້ ມູນທີ່ ບັນທຶກໄວ້ 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6) ແລ້ວເຮົ າກໍຈະໄດ້ຂອບເຂດທີ່ ເຮົ າຕ້ອງການສະແດງຢູ່ໃນ Google Earth 

2 

1

2

2 

3 

4

5 
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ໝາຍເຫດ: ສາມາດສ້າງໄດ້ທັັງຂໍ ້ ມູນທີ່ ເປັນຈຸດ ແລະ ເປັນເສ້ັນ 

1. ຂ້ັນຕອນການບັກທຶ ກເອົ າຮູບພາບຈາກ Google Earth 

1) File > Save > Save Image 

2) ເລື ອກຄວາມລະອຽດຂອງພາບທີ່ ເຮົ າຕ້ອງການ 

3) Save 

 

 

 

 

 

 

 

 

6

1 

2 
1

3 

1 
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3.5. ການດັດແກ້ພາບ Google earth  (Georefensing) 

ການດັດແກ້ພາບຖ່າຍ ຫຼື  ຮູບພາບທີ່ ບໍ່ ມີ ຈຸດອ້າງອີ ງໃຫມີ ຈຸດອ້າງອີ ງ ໃນບາງການເຮັດວຽກຕົວຈີ ງ 
ເຮົ າບໍ່ ມີ ຂໍ ້ ມູນຂອບ ຫຼື ້  ຂໍ ້ ມູນອື່ ນໆ ທີ່ ເປັນຂໍ ້ ມູນ shp ແຕ່ເຮົ າມີ ຂໍ ້ ມູນຮູບພາບຈາກກ້ອງ ຫຼື  ຮູບພາບ
ຈາກ google earth  ທີ່ ເປັນຂໍ ້ ມູນ ຮູບພາບທໍາມະດາບໍ່ ມີ ຈຸດອ້າງອີ ງ ຫຼື  ລະບົບພິກັດທາງພູມສາດ  
ນໍ າມາປັບແກ້ໃຫ້ມີ ລະບົບພິກັດເພ່ືອນໍ າໃຊ້ຂໍ ້ ມູນເປັນບ່ອນອີ ງໃນການສ້າງຊ້ັນຂໍ ້ ມູນອື່ ນໆ......ຂໍ ້ ມູນ
ທີ ຕ້ອງກຽມມີ ຂໍ ້ ມູນພາບ,ຂໍ ້ ມູນຈຸດອ້າງອີ ງພາກພື ້ ນດິ ນ (GCP)  

ເປີ ດ Google earth ແລ້ວຊຸ່ມໄປຫາພ້ືນທີ່ ທີ່ ຕ້ອງການ ແລ້ວ ເພີມຈຸດທີ ທີ່ ຈະໃຊ້ເປັນບ່ອນອີ ງ 4 ໃຫ້
ແຕ່ລະແຈຂອງພາບ  

  

 

 

 

 

 

 

 

 

 

 

ການປັບແກ້ຂໍ ້ ມູນພາບຖ່າຍ google earth ການບັນທຶກຂໍ ້ ມູນພາບ 
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ກາ 

 

 

 

 

 

 

 

 

 

 

ການບັນທຶກຈຸດອີ ງຂອງພາບ ແລະ ພາບຖ່າຍ 

 

ໃສ່ຊື່  ແລະ ຕົກລົງ 

ເອີ ້ ນຂໍ ້ ມູນທີ່ ເປັນ KML

ເລື ອກຊ່ອງ
ເກັບມ້ຽນຂໍ ້
ມູນ 
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ການນໍ າຂໍ ້ ມູນຈຸດອ້າງອີ ງເຂົ ້ າ (KML OR KMZ) 

 

 

 

 

 

 

 

 

   

ເມື່ ອນໍ າຂໍ ້ ມູນຈຸດອີ ງ ແລະ ພາບຖ່າຍ ຈະເຫັນວ່າຂໍ ້ ມູນທັງສອງ
ແມ່ນບໍ່ ສ້ອນທັບກັນ ໂດຍສະເພາະຂໍ ້ ມູນພາບ  
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ບົດທີ  4: ການສ້າງຂໍ ້ ມູນສວນປູກ ຫຼື  ຂໍ ້ ມູນການນໍ າໃຊ້ທີ່ ດິ ນຈາກພາບຖ່າຍ 

4.1. ການສ້າງຂໍ ້ ມູນການນໍ າໃຊ້ທີ່ ດິ ນຈາກພາບຖ່າຍ 

ເປັນການແຕ້ມຂໍ ້ ມູນຈາກພາບຖ່າຍທີ່ ມີ ຄວາມລະອຽດສູງທີ່ ສາມາດແປດ້ວຍສາຍຕາໄດ້ລາຍ
ລະອຽດມີ ດ່ັງນີ ້ : 

1) ເລີ່ ມຈາກການເປີ ດໂປຼແກມ Arc Map ຂຶ ້ ນມາ ແລ້ວຄລີ ກໃສ່ Catalog  

  
 

2) ເລື ອກບ່ອນເກັບມ້ຽນຂໍ ້ ມູນ (ຊ່ອງເກັບມ້ຽນຂໍ ້
ມູນ) ຖ້າບໍ່ ມີ ຕ້ອງສ້າງໃໝ່ແລ້ວໃສ່ຊື່  ແລະ 
ຕ້ອງຈັດໃຫ້ຖື ກກັບປະເພດຂໍ ້ ມູນ 

3) ຄີ ກຂວາແລ້ວເລື່ ອນເມ້ົາໄປຫາ New >> 
shapefile  
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ໃສ່ຊື່ ຊ້ັນຂໍ ້ ມູນ 

ເລື ອກປະເພດຂໍ ້ ມູນເຊັ່ ນ: ຂໍ ້ ມູນຈຸດ, 
ເສ້້ັນ ແລະ ຂໍ ້ ມູນພ້ືນທີ  (ເລື ອກໄດ້ເທື່ ອ
ລ ຂໍ ້ ມນ)

ເລື ອກຈຸດອ້າງອີ ງຂອງຂໍ ້ ມູນ 

Projection 

ໃນການເລື ອກ projection ຕ້ອງເບີ່ ງພື ້ ນ 

ທີ່ ຂອງເຮົ າຢູ່ພື ້ ນທີ່ ໃດ ສະເພາະຢູ່ລາວ 

ແມ່ນນອນຢູ່ໃນ Zone 47 and Zone 48  
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ຫັຼງຈາກເຮົ າໄດ້ຊ້ັນຂໍ ້ ມູນແລ້ວເຮົ າໄປແກ້ໄຂຂໍ ້ ມູນໂດຍ ໄປທີ່  Editor  >> Start Editing 

 

ແລ້ວເຮົ າກ່ໍຈະໄດ້ຂໍ ້ ມູນທີ່ ເປັນ shp  

ວິ ທີ ການແຕ້ມ 
1)ຄລີ ກໃສ່ຊ້ັນຂໍ ້ ມູທີ່ ຕ້ອງການແຕ້ມ 
2)ແຕ້ມອ້ອມພ້ືນທີ ການນໍ າໃຊທີ່

ດິ ນ 
3)ຫັຼງແຕ້ມແລ້ວໄປທີ່  Editor  >>  
Stop Editing ແລ້ວບັນທຶກ 
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4.2. ການໃສ່ຊື່ ຂໍ ້ ມູນ ແລະ ການຄໍ ານວນເນື ້ ອທີ່  

ຫັຼງຈາກແຕ້ມຂໍ ້ ມູນປະເພດການນໍ າໃຊ້ທີ່ ດິ ນແລ້ວ ຈາກນ້ັນກ່ໍບັນທຶກຂໍ ້ ມູນໂດຍ Editor  >>  Save 

Edits ແລ້ວ  Stop Editing ຕ່ໍໄປຈະເປັນການເພ່ີມຖັນຂໍ ້ ມູເພ່ືອໃສ່ຊື່  ແລະ ຄິ ດໄລເນື ້ ອທີ່ ປະເພດ
ການນໍ າໃຊ້ທີ່ ດິ ນ 

 
 

 

 

 

 

 

 

 

 

 

 

1)ຄລີ ກຂວາໃສ່ຊ້ັນຂໍ ້ ມູນ
ປະເພດນໍ າໃຊ້ທີ່ ດິ ນ ແລ້ວໄປທີ່  
Open Attribute table 

2)ທີ່ ເມນູ Table Option 

ແລ້ວໄປທີ່  Add Field   
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3)ໃສ່ຊື່ ຖັນຂໍ ້ ມູນ ແລ້ວ
ເລື ອກປະເພດຂໍ ້ ມູນ ຖ້າ
ເປັນຕົວເລກໃຫ້ເລື ອກ 
Double 
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 ການຄໍ ານວນເນື ້ ອທີ່  Calculate Geometry 

 
 

 

 

4)ເລື ອກ polygon ທີ່

ຕ້ອງການໃສ່ຊື່  

5)ຄລີ ກຂວາໃສ່ຫົວຖັນ
ແລ້ວໄປທີ່  Field Calculator 
ແລ້ວພີມຂໍ ້ ມູນທີ່ ຕ້ອງການ
ເຕີ ມ ຕົວຢ່າງ “Rubber 
Tree”  

1) ຄລີ ກຂວາໃສ່ຫົວຖັນ 
Area_ha ແລ້ວໄປທີ່  
Calculate Geometry 

2)ເລື ອກທີ່ ຫ້ອງທີ່ ໜ່ືງ ເປັນ Area 
ແລະ ຫ້ອງ Units ເລື ອກເປັນເຮັກ
ຕ້າ ຫຼື  ຕາເມັດກ່ໍໄດ້ 
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4.3. ການສ້ງຂໍ ້ ມູນໃໝ່ໂດຍອີ ງໃສ່ຂໍ ້ ມູນຈາກຕາຕາລາງ 

ວິ ທີ ການເຮັດ 
1. ນໍ າຂໍ ້ ມູນເຂົ ້ າໃນແຊວ ແລ້ວ ບັນທຶກ  

 

 

2. ເປເປີ ດໂປຼແກມ Arc Map ຂື ້ ມາແລ້ວ ນໍ າເຂົ ້ າຂໍ ້ ມູນ 

 

1

ເລື ອກເອົ າຂໍ ້ ມູນ
ເອັກແຊວທີ່ ເຮົ າ
ບັນທຶກໄວ້ອອກມາ 
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3.   

 

 

 

 

 

 

 

 

 

 

 

 

 

3. ຫັຼງຈາກໄດ້ຊ້ັນຂໍ ້ ມຸນ
ແລ້ວ ຄີ ກຂວາເຂົ ້ າຫາ 
Display XY Data 

- ຫ້ອງ X Field ເລື ອກເປັນ X 

- ຫ້ອງ Y Field ເລື ອກເປັນ Y  

4. ເລື ອກ Projected ໃຫ້ຂໍ ້ ຂອງເຮົ າ 

- ຄີ ກທີ່   Edit 

ຈະປະກົດໜ້າໃໝ່ຂື ້ ນມາ ກົດປຸ່ມ Select ແລ້ວ
ເລື ອກ Projected Coordinate system  >> UTM 
>> WGS >> WGS 1984 UTM Zone 48N.pbj 
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4. ຫັຼງຈາກນ້ັນເຮົ ້ າຈະໄດ້ຂໍ ້ ມູນໃໝ່ດັງຮູບ ແຕ່ຂໍ ້ ມູນດ່ັງກ່າວຍັງບໍ່ ໄດ້ຖື ກບັນທຶກ ສະນ້ັນ
ເຮົ າຕ້ອງບັນທຶ ກໂດຍຄີ ກຂວາທີ່ ຊ້ັນຂໍ ້ ມູນແລ້ວໄປທີ່  >> Data >> Export Data >>ໃສ່ຊື່  
ແລະ ບັນທຶກ 

 
ຖ້າສົມມຸດວ່າເຮົ ້ າມີ ຂໍ ້ ມູນທີ່ ເປັນຈຸດແລ້ວເຮົ າຢາກ ສ້າງເປັນພ້ືນທີ່ ໂດຍໃຊ້ຂໍ ້ ມູນຈຸດທີ່ ເຮົ າໄປຈັບມາ 
ເພ່ືອຄໍ ານວນຫາເນື ້ ອທີ່  

ວິ ທີ ການເຮັດ  

1. ເມື່ ອເຮົ າໄດ້ຂໍ ້ ມູນຈຸດແລ້ວເຮົ າເປີ ດ Xtools Pro ແລ້ວໄປທີ່  ຄໍ າສ່ັງ Make Polygon from 
Point   ດ່ັງຮູບລຸ່ມນີ ້ : 
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2. ແລ້ວເລື ອກຂໍ ້ ມູນທີ່ ຕ້ອງການສ້າງເປັນພ້ືນທີ່  

  

ເລື ອກຂໍ ້ ມູນທີ່

ຕ້ອງການ 

ເລື ອກບ່ອນເກັບ
ມ້ຽນ ແລ້ວໃສ່ຊື່  
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ຖ້າເຮົ າຕ້ອງການສ້າງຂໍ ້ ມູນໃຫ້ເປັນເສ້ັນເພື່ ອຈະຄໍ ານວນຫາໄລຍະທາງ  

1. ເມື່ ອເຮົ າໄດ້ຂໍ ້ ມູນຈຸດແລ້ວເຮົ າເປີ ດ Xtools Pro ແລ້ວໄປທີ່  ຄໍ າສ່ັງ Make Polylines from Point   
ດ່ັງຮູບລຸ່ມນີ ້ : 

 

ແລ້ວຈະໄດ້ຂໍ ້ ມູນທີ່ ເປັນພ້ືນ
ທີ່  ສ່ວນຮູບຂອງພ້ືນທີ່ ຈະ
ເປັນແບບໃດນ້ັນຂື ້ ນກັບ
ການລໍ າດັບຂອງຈຸດເຮົ າ 
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ແລ້ວຈະໄດ້ຂໍ ້ ມູນທີ່ ເປັນພ້ືນທີ່  ສ່ວນຮູບຂອງພ້ືນທີ່ ຈະເປັນແບບໃດນ້ັນຂື ້ ນກັບການລໍ າດັບຂອງຈຸດ
ເຮົ າ 

 

ເລື ອກບ່ອນເກັບ
ມ້ຽນ ແລ້ວໃສ່ຊື່  

ເລື ອກຂໍ ້ ມູນທີ່

ຕ້ອງການ
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4.4. ວິ ທີ ການແປພາບຈາກໂປລແກມ ArcGIS 

1) ການຈໍ າແນກແບບມີ ກໍາກັບ (Supervised Classification) 

 

 

 

 

 

 

 

 

 

 

 

 1 ເປີ ດພາບຖ່າຍທີ່ ຕ້ອງການແປຂື ້ ນມາ ແລ້ວປະສົມສີ ພາບໃຫ້ໃກ້ຄຽງກັບສີ ທໍາມະຊາດ 
(5,4,3) 

 2 ເພ່ີມເຄື່ ອງມື  Image Classification ຂື ້ ນມາ 

 

 

 

 

 

 

 

1

2

2
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 ກ່ອນອື່ ນເຮົ າຕ້ອງສ້າງ Signature file ຫຼື  ຈຸດຕົວຢ່າງຂື ້ ນມາກ່ອນ 
 3 ຢູ່ໃນເຄື່ ອງມື  Image Classification ໃຫ້ເປີ ດ Training Sample Manager ຂື ້ ນມາ 
 4 ເລື ອກ Draw polygon ເພ່ືອແຕ້ມຈຸດຕົວຢ່າງ 
 5 ແຕ້ມ (ກໍານົດ) ພື ້ ນທີ່ ຕົວຢ່າງ 
 6 ຫັຼງຈາກກໍານົດພ້ືນທີ່ ຕົວຢ່າງແລ້ວໆ ກໍ Save file ໄວ້ໂຟນເດີ ທີ່ ຕ້ອງການ 

 

 

 

 

 

 

 

 

3 4 

5 

5 

6
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 7 ຢູ່ໃນເຄື່ ອງມື  Image Classification ເລື ອກ Classification 
 8 ເລື ອກ Maximum Likelihood Classification 
 9 ເລື ອກຮູບພາບດາວທຽມທີ່ ຈະແປ 
 10 ເລື ອກໄຟລ Signature file ທີ່ ເຮົ າສ້າງໄວ້ກ່ອນໜ້ານີ ້  
 11 ເລື ອກໂຟນເດີ ທີ່ ຈະເກັບພາບໄວ້ 
 12 ກົດ OK 

 
 
 
 
 
 
 
 
 
 

7 

8

9

10

12

11
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2) ການຈໍ າແນກແບບບໍ່ ມີ ກໍາກັບ (Unsupervised Classification) 

 

 

 

 

 

 

 

 

 

 

 

 

1 

2 

2 
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 1 ເປີ ດພາບຖ່າຍທີ່ ຕ້ອງການແປຂື ້ ນມາ ແລ້ວປະສົມສີ ພາບໃຫ້ໃກ້ຄຽງກັບສີ ທໍາມະຊາດ 
(5,4,3) 

 2 ເພ່ີມເຄື່ ອງມື  Image Classification ຂື ້ ນມາ 
 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 3 ຢູ່ໃນເຄື່ ອງມື  Image Classification ເລື ອກ Classification 
 4 ເລື ອກ Iso Cluster Unsupervised Classification 
 5 ເລື ອກຮູບພາບດາວທຽມທີ່ ຈະແປ 
 6 ໃສ່ຈํານວນປະເພດການນາํໃຊ້ທີ່ ດິ ນທີ່ ຕ້ອງການ 
 7 ເລື ອກໂຟນເດີ ທີ່ ຈະເກັບພາບໄວ້ 
 8 ກົດ OK 

 

3 

4

5 

6 

7 

8



66 
 

 

 

 

 

 

 

 

 

 

 

4.5. ການນໍ າໃຊ້ Impact Toolbox 

ເປັນໂປຼແກມທີ່ ລວມເອົ າເຄື່ ອງມື  RS, GIS, Statistics ໄວ້ນໍ າກັນ, ປະຢັດຄ່າໃຊ້ຈ່າຍໃນການຊື ້
ຊອບແວ (Licensing/training), ລະບົບເຮັດວຽກເປັນ open source, ງ່ າຍຕ່ໍການນໍ າໃຊ້ (ຕິດຕ້ັງ
ງ່ າຍ, ບໍ່່ ຕ້ອງ ການ internet ແລະ ສາມາດໃຊ້ອອນໄລໄດ້) 

 ການນໍ າໃຊ້ impact toolbox ແປພາບຖ່າຍ 

ຈາກຂໍ ້ ມູນດິ ບ (ພາບຖ່າຍດາວທຽມ) ໄປສູ່ ແຜນທີ່ ຄວາມປົກຫຸ້ມໜ້າດິ ນ 
 ກ່ອນການດໍ າເນີ ນງານຂອງເຄື່ ອງມື   

 - ການດຶ ງຂໍ ້ ມູນ: ເອົ າຂໍ ້ ມູນອອກ > ການປະສົມຊ້ັນຂໍ ້ ມູນ > radiometric calibration 

 - ການຕັດຂໍ ້ ມູນ 

 - Normalization evergreen forest (Globcover2009 + Hansen 2013 tree cover 
>65%) 
 - ການເຊື່ ອມຕ່ໍຂໍ ້ ມູນ 

 ການຈັດແບ່ງປະເພດ 
 - ການຈັດແບ່ງປະເພດເປັນອັດຕະໂນມັດ 

 - Spectral unmixing 

 - ການຄໍ ານວນຄ່າດັດຊະນີ ພືດພັນ + ການປົກຄຸມສະເພາະ
ປ່າໄມ້  
 - ການແບ່ງສັດສ່ວນ (object-based classification – also 
multi-date approach possible) 
 - ການຕິດຕາມກວດກາການເຊື່ ອມໂຊມຂອງປ່າໄມ້ 
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 ຫັຼງຈາກການດໍ າເນີ ນງານ 
 - ການກວດສອບການປົກຫຸ້ມໜ້າດິ ນ (attribute editing) 
 -  Ground truth collection 
 -  ການກໍານັດພ້ືນທີ່ ຕົວຢ່າງເພ່ືອການສໍ າຫຼວດ (Fishnet creation) 
 -  ການດຶ ງຂໍ ້ ມູນສະຖິຕິ 
 
 ໜ້າຫັຼກຂອງໂປຼແກມ 

 

 
 ການນໍ າຂໍ ້ ມູນພາບເຂົ ້ າໃນ Impact Tools  
 ການນໍ າເຂົ ້ າຂໍ ້ ມູນພາບຖ່າຍ ພຽງແຕ່ກອບປີ ຂໍ ້ ມູນພາບໄປໃສ່ ຊ່ອງ

C:\IMPACT\DATA\RAW_data 

ເຄື່ ອງມືສໍ າລັບແຕ້ມ 

ໜ້າສະແດງຊ້ັນຂໍ ້ ມູນ ແລະ 
ປີ ດເປີ ດຂໍ ້ ມູນ 

ໝວດຄໍ າສ່ັງປະມວນຜົນ 
ແລະ ວິ ເຄາະພາບຖ່າຍ 
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 ຫັຼງຈາກນ້ັນກ່ໍເປີ ດ ໂປຼແກມ IMPACT Toolbox ຂຶ ້ ນມາແລ້ວເບິ່ ງທີ່ ແຖບ Zip/DN to TOA-
Reflectance ໃນນີ ້ ຈະມີ  3 ປະເພດພາບຄື : Landsat, Sentinel-2, RapidEye ໃນກ່ໍນີ ນີ ້ ຂໍ ້ ມູນ

ຂອງເຮົ າແມ່ນ Landsat ສະນ້ັນຈຶ່ ງຄລີ ກໃສ່ Landsat ດ່ັງຮູບ 
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 ການປັບແກ້ພາບ ຫຼື  ລົດສິ່ ງລົບກວນຂອງພາບ (ຂີ ້ ເຝ້ືອ ແລະ ໝອກຂວັນ) 

 
 

 

 

1)ຄລີ ກໃສ່ Possessing tools 

2) ຄລີ ກໃສ່ Evg Forest Narmal 

3) ເລື ອກເອົ າທີ່ ຕ້ອງການດັດແກ້ 
ແລ້ວ ຄລີ ກ RUN 
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 ການຕັດພາບ  

 

 ການແປພາບໂດຍອັດຕະໂນມັດ Automatic Classification  

 
  

1)ຄລີ ກໃສ່ Image Clip 

2) ເລື ອກເອົ າຂອບເຂດທີ່

ຕ້ອງການ 

3) ເລື ອກເອົ າພາບທີ່ ຕ້ອງການຕັດ
ແລ້ວ ຄລີ ກ RUN 

1)ຄລີ ກໃສ່ Automatic Classification 

2) ເລື ອກເອົ າພາບທີ່ ຕ້ອງການແປ
ແລ້ວ ຄລີ ກ RUN 
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 ການຕ່ໍພາບ Mosaic image 

 
 

 

1)ກອບປຼີ  ຮູບທີ່ ຕ້ອງຕ່ໍໄປໄວ້ (ກ່ໍລະນີ ພາບ
Sentinle) 
C:\IMPACT\DATA\CALIBRATED_data 

2) ຄລີ ກໃສ່ Possessing tools >> Mosaic 
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 Fishnet  

 
 

3)ເລື ອກເອົ າພາບທີ່

ຕ້ອງການຕ່ໍແລ້ວ 
ຄລີ ກ RUN 
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